Edition: November 2005

The following paragraph does not apply to any country where such provisions are inconsistent with local law: LEXMARK INTERNATIONAL, INC., PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions; therefore, this statement may not apply to you.

This publication could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in later editions. Improvements or changes in the products or the programs described may be made at any time.

Comments about this publication may be addressed to Lexmark International, Inc., Department F95/032-2, 740 West New Circle Road, Lexington, Kentucky 40550, U.S.A. In the United Kingdom and Eire, send to Lexmark International Ltd., Marketing and Services Department, Westhorpe House, Westhorpe, Marlow Bucks SL7 3RQ. Lexmark may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you. You can purchase additional copies of publications related to this product by calling 1-800-553-9727. In the United Kingdom and Eire, call +44 (0) 8704 440 044. In other countries, contact your point of purchase.

References in this publication to products, programs, or services do not imply that the manufacturer intends to make these available in all countries in which it operates. Any reference to a product, program, or service is not intended to state or imply that only that product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any existing intellectual property right may be used instead. Evaluation and verification of operation in conjunction with other products, programs, or services, except those expressly designated by the manufacturer, are the user’s responsibility.

© 2006 Lexmark International, Inc.
All rights reserved.

UNITED STATES GOVERNMENT RIGHTS

This software and any accompanying documentation provided under this agreement are commercial computer software and documentation developed exclusively at private expense.

Safety information

- Use only the power supply and power cord provided with this product or the manufacturer’s authorized replacement power supply and power cord.
- Connect the power supply cord to a properly grounded electrical outlet that is near the product and easily accessible.
- Refer service or repairs, other than those described in the user documentation, to a professional service person.
- Use only a 26 AWG or larger telecommunications (RJ-11) cord when connecting this product to the public switched telephone network.

CAUTION: Do not use the fax feature during a lightning storm. Do not set up this product or make any electrical or cabling connections, such as the power cord or telephone, during a lightning storm.
Contents

Finding information about the printer
Setting up the printer
Learning about the printer
Learning about the software
Loading paper and original documents..........................................................34
  Loading paper..........................................................................................34
  Loading various paper types..................................................................35
  Loading original documents into the ADF..............................................38
  Loading original documents on the scanner glass...............................39

Printing........................................................................................................41
  Printing a document.............................................................................41
  Printing collated copies.....................................................................41
  Printing the last page first (reverse page order).................................41
  Printing transparencies.......................................................................42
  Printing envelopes..............................................................................42
  Printing multiple pages on one sheet................................................42
  Printing cards......................................................................................43

Copying........................................................................................................44
  Making a copy......................................................................................44
  Collating copies..................................................................................44
  Repeating an image on one page.......................................................45
  Enlarging or reducing an image.........................................................45

Scanning.......................................................................................................47
  Scanning a document..........................................................................47
  Scanning documents or images for e-mailing....................................47
  Scanning text for editing....................................................................48
  Scanning images for editing...............................................................48
  Scanning clear images from magazines or newspapers..................48
  Scanning to a computer over a network..........................................49

Faxing..........................................................................................................50
  Sending a fax......................................................................................50
    Entering a fax number.....................................................................50
    Sending a fax using the control panel............................................51
    Sending a fax using the computer................................................51
    Sending a broadcast fax at a scheduled time...............................52
    Sending a fax while listening to a call (On Hook Dial).................52
  Receiving a fax..................................................................................53
    Receiving a fax automatically......................................................53
    Receiving a fax with an answering machine..............................53
Troubleshooting...........................................................................................................75

Maintaining the printer................................................................................................69
Changing print cartridges............................................................................................69
Removing a used print cartridge..................................................................................69
Installing print cartridges............................................................................................70
Achieving better print quality......................................................................................71
Improving print quality...............................................................................................71
Aligning print cartridges..............................................................................................71
Cleaning the print cartridge nozzles............................................................................72
Wiping the print cartridge nozzles and contacts.........................................................72
Preserving the print cartridges......................................................................................73
Cleaning the scanner glass.........................................................................................73
Ordering supplies.........................................................................................................74
Recycling Lexmark products.......................................................................................74

Preserving the print cartridges......................................................................................73
Cleaning the scanner glass.........................................................................................73
Ordering supplies.........................................................................................................74
Recycling Lexmark products.......................................................................................74

Troubleshooting...........................................................................................................75
Setup troubleshooting.................................................................................................75
Incorrect language appears on the display.................................................................75
Power button is not lit..................................................................................................76
Software does not install.............................................................................................76
Page does not print.......................................................................................................77
Cannot print from digital camera using PictBridge....................................................79
Print troubleshooting.................................................................................................79
Improving print quality...............................................................................................79
Poor text and graphic quality......................................................................................80
Poor quality at the edges of the page..........................................................................81
Printer does not print or respond...............................................................................81
Print speed is slow........................................................................................................81
Partial document or photo prints...............................................................................82
Copy troubleshooting.................................................................................................82
Copier does not respond............................................................................................82
Scanner unit does not close.......................................................................................83
Poor copy quality........................................................................................................83
Partial document or photo copies...............................................................................84
Scan troubleshooting.................................................................................................84
Scanner does not respond..........................................................................................84
Scanning takes too long or freezes the computer.......................................................84
Scan was not successful.............................................................................................85
Poor scanned image quality.......................................................................................85
Partial document or photo scans...............................................................................86
Cannot scan to an application....................................................................................86
Cannot scan to a computer over a network...............................................................86
Fax troubleshooting.................................................................................................86
Tips for faxing using the Productivity Suite..............................................................86
Cannot send or receive a fax.....................................................................................86
Can send but not receive faxes.........................................................................................88
Can receive but not send faxes.........................................................................................88
Printer receives a blank fax.........................................................................................89
Received fax has poor print quality.............................................................................90
Network troubleshooting.............................................................................................91
The printer to be configured does not appear in the list of printers found on your network......91
Cannot print to the network printer.............................................................................91
Network name does not appear in the list.....................................................................92
Jams and misfeeds troubleshooting.............................................................................92
Paper jam in the printer...............................................................................................92
Paper jam in the ADF.................................................................................................92
Paper or specialty media misfeeds.............................................................................93
Printer does not feed paper, envelopes, or specialty media.......................................93
Banner paper jams....................................................................................................94
Error messages........................................................................................................94
Black Ink Low/Color Ink Low/Photo Ink Low.................................................................94
Clear Paper Jam.......................................................................................................94
Clear ADF Jam.........................................................................................................94
Left Cartridge Error/Right Cartridge Error...............................................................94
Cartridge Error........................................................................................................95
Clear Carrier Jam.....................................................................................................95
Left Cartridge Missing/Right Cartridge Missing......................................................96
Error: 1104...............................................................................................................96
Alignment Problem...................................................................................................97
Fax Error..................................................................................................................97
Fax Mode Unsupported.............................................................................................97
Failed to Connect.....................................................................................................97
Phone Line Error.....................................................................................................98
Remote Fax Error.....................................................................................................98
Phone Line Busy......................................................................................................99
Memory Full............................................................................................................100
Removing and reinstalling the software..............................................................100

Notices..................................................................................................................102
Power consumption.................................................................................................106

Index.....................................................................................................................108
## Finding information about the printer

### Setup sheet

<table>
<thead>
<tr>
<th>Description</th>
<th>Where to find</th>
</tr>
</thead>
<tbody>
<tr>
<td>The <em>Setup</em> sheet gives you instructions for setting up hardware and software.</td>
<td>You can find this document in the printer box or on the Lexmark Web site.</td>
</tr>
</tbody>
</table>

### User’s Guide

<table>
<thead>
<tr>
<th>Description</th>
<th>Where to find</th>
</tr>
</thead>
<tbody>
<tr>
<td>The <em>User’s Guide</em> gives you instructions for using the printer and other information such as:</td>
<td>You can find this document on the Lexmark Web site. When you install the printer software, the <em>User’s Guide</em> may also be installed.</td>
</tr>
<tr>
<td>• Maintenance</td>
<td>1 Click <em>Start → Programs</em> or <em>All Programs → Lexmark 7300 Series</em>.</td>
</tr>
<tr>
<td>• Troubleshooting</td>
<td>2 Click <em>User’s Guide</em>.</td>
</tr>
<tr>
<td>• Safety</td>
<td></td>
</tr>
</tbody>
</table>

### CD

<table>
<thead>
<tr>
<th>Description</th>
<th>Where to find</th>
</tr>
</thead>
<tbody>
<tr>
<td>The CD contains drivers, software, and publication files.</td>
<td>You can find this CD in the printer box. See the <em>Setup</em> sheet for installation instructions.</td>
</tr>
<tr>
<td>The CD installs the Help system on your computer if your printer connects to a computer.</td>
<td></td>
</tr>
</tbody>
</table>

### Help

<table>
<thead>
<tr>
<th>Description</th>
<th>Where to find</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Help gives you instructions for using the software if your printer connects to a computer.</td>
<td>While in any Lexmark software program, click <em>Help</em>, <em>Tips → Help</em>, or <em>Help → Help Topics</em>.</td>
</tr>
</tbody>
</table>

### Lexmark Solution Center

<table>
<thead>
<tr>
<th>Description</th>
<th>Where to find</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Lexmark Solution Center software is included on your CD if your printer connects to a computer. It installs with the other software.</td>
<td>To access the Lexmark Solution Center: 1 Click <em>Start → Programs</em> or <em>All Programs → Lexmark 7300 Series</em>. 2 Select <em>Lexmark Solution Center</em>.</td>
</tr>
</tbody>
</table>

### Readme file

<table>
<thead>
<tr>
<th>Description</th>
<th>Where to find</th>
</tr>
</thead>
<tbody>
<tr>
<td>This file contains late-breaking information about the printer and software that does not appear in other documentation, as well as information specific to your operating system.</td>
<td>To access the Readme file: 1 Click <em>Start → Programs</em> or <em>All Programs → Lexmark 7300 Series</em>. 2 Select <em>Readme</em>.</td>
</tr>
</tbody>
</table>
Web site

<table>
<thead>
<tr>
<th>Description</th>
<th>Where to find</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong> All paths for the Web site are subject to change.</td>
<td>1 Go to the Web site.</td>
</tr>
<tr>
<td></td>
<td>2 Select a country from the drop-down list in the upper-left corner of the page.</td>
</tr>
<tr>
<td></td>
<td>3 Select the link for the information you need.</td>
</tr>
</tbody>
</table>

Record the following information (located on the store receipt and the back of the printer), and have it ready when you contact us so that we may serve you faster:

- Machine Type number
- Serial number
- Date purchased
- Store where purchased
Setting up the printer

Checking the box contents

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1  Black print cartridge</td>
<td>Cartridges to be installed into the printer.</td>
</tr>
<tr>
<td>2  Color print cartridge</td>
<td><strong>Note:</strong> Cartridge combinations vary depending on the product purchased.</td>
</tr>
<tr>
<td>3  Telephone cord</td>
<td>Use for faxing. For more information about connecting this cord, see</td>
</tr>
<tr>
<td></td>
<td>“Choosing a fax connection” on page 12.</td>
</tr>
<tr>
<td>4  Power supply cord</td>
<td>Attaches to the power supply port located at the back of the printer.</td>
</tr>
<tr>
<td>5  Setup sheet</td>
<td>Instructions on setting up printer hardware and software, and information</td>
</tr>
<tr>
<td></td>
<td>on setup troubleshooting.</td>
</tr>
<tr>
<td>6  Installation software CD</td>
<td>Installation software for the printer. Also includes the printer software</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Installing the printer software also installs the Help.</td>
</tr>
<tr>
<td>7  User’s Guide or Setup</td>
<td>Printed booklet that serves as a guide.</td>
</tr>
<tr>
<td>Solutions</td>
<td></td>
</tr>
</tbody>
</table>

Installing another language control panel

These instructions apply only if you received one or more additional language control panels with the printer.

1. Lift and remove the control panel (if one is installed).
2 Choose the correct control panel for your language.

3 Align the clips on the control panel with the holes on the printer, and then press down.

Getting the printer ready to fax

Choosing a fax connection

You can connect the printer with equipment such as a telephone, an answering machine, or a computer modem. If problems occur, see “Setup troubleshooting” on page 75.

Note: The printer is an analog device that works best when directly connected to the wall jack. Other devices (such as a telephone or answering machine) can be successfully attached to pass through the printer, as described in the setup steps. If you want a digital connection such as ISDN, DSL, or ADSL, a third-party device (such as a DSL filter) is required.

You do not need to attach the printer to a computer, but you do need to connect it to a telephone line to send and receive faxes.

You can connect the printer to other equipment. See the following table to determine the best way to set up the printer.

<table>
<thead>
<tr>
<th>Equipment</th>
<th>Benefits</th>
<th>See this section</th>
</tr>
</thead>
<tbody>
<tr>
<td>• The printer</td>
<td>Send and receive faxes without using a computer.</td>
<td>“Connecting directly to a telephone wall jack” on page 13</td>
</tr>
<tr>
<td>• A telephone cord</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• The printer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• A telephone</td>
<td>• Use the fax line as a normal telephone line.</td>
<td>“Connecting to a telephone” on page 13</td>
</tr>
<tr>
<td>• Two telephone cords</td>
<td>• Send and receive faxes without using a computer.</td>
<td></td>
</tr>
<tr>
<td>• The printer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• A telephone</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• An answering machine</td>
<td>Receive both incoming voice messages and faxes.</td>
<td>“Connecting to an answering machine” on page 14</td>
</tr>
<tr>
<td>• Three telephone cords</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• The printer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• A telephone</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• A computer modem</td>
<td>Send faxes using the computer or the printer.</td>
<td>“Connecting to a computer with a modem” on page 16</td>
</tr>
<tr>
<td>• Three telephone cords</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Connecting directly to a telephone wall jack

Connect the printer directly to a telephone wall jack to make copies or send and receive faxes without using a computer.

1. Make sure you have a telephone cord and a telephone wall jack.

2. Connect one end of the telephone cord into the LINE port of the printer.

3. Connect the other end of the telephone cord into an active telephone wall jack.

Note: For more information on connecting the printer to telecommunications equipment, see the additional setup instructions that came with the printer. Setup steps may vary depending on your country.

Connecting to a telephone

Connect a telephone to the printer to use the fax line as a normal telephone line. Then set up the printer wherever your telephone is located to make copies or send and receive faxes without using a computer.

1. Make sure you have the following:
   - A telephone
   - Two telephone cords
   - A telephone wall jack

2. Connect one telephone cord to the LINE port of the printer, and then plug it into an active telephone wall jack.
3 Remove the protective plug from the EXT port of the printer.

4 Connect the other telephone cord to a telephone, and then plug it into the EXT port of the printer.

**Note:** For more information on connecting the printer to telecommunications equipment, see the additional setup instructions that came with the printer. Setup steps may vary depending on your country.

**Connecting to an answering machine**

Connect an answering machine to the printer to receive both incoming voice messages and faxes.

1 Make sure you have the following:
   • A telephone
   • An answering machine
   • Three telephone cords
   • A telephone wall jack
2 Connect one telephone cord into the LINE port of the printer, and then plug it into an active telephone wall jack.

3 Remove the protective plug from the EXT port of the printer.

4 Connect a second telephone cord from the telephone to the answering machine.

5 Connect a third telephone cord from the answering machine to the EXT port of the printer.

Note: For more information on connecting the printer to telecommunications equipment, see the additional setup instructions that came with the printer. Setup steps may vary depending on your country.
Connecting to a computer with a modem

Connect the printer to a computer with a modem to send faxes from the software application.

1 Make sure you have the following:
   • A telephone
   • A computer with a modem
   • Three telephone cords
   • A telephone wall jack

2 Connect a telephone cord into the LINE port of the printer, and then plug it into an active telephone wall jack.

3 Remove the protective plug from the EXT port of the printer.

4 Connect a second telephone cord from the telephone to the computer modem.
5 Connect a third telephone cord from the computer modem to the EXT port of the printer.

Note: For more information on connecting the printer to telecommunications equipment, see the additional setup instructions that came with the printer. Setup steps may vary depending on your country.
Learning about the printer

Understanding the parts of the printer

<table>
<thead>
<tr>
<th>Use the</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Automatic Document Feeder (ADF)</td>
<td>Scan, copy, or fax multiple-page letter, legal, and A4 size documents.</td>
</tr>
<tr>
<td>2 ADF input tray</td>
<td>Load original documents in the ADF. Recommended for scanning, copying, or faxing multiple-page documents.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: Do not load postcards, photos, small items, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.</td>
</tr>
<tr>
<td>3 ADF exit tray</td>
<td>Pick up your original document after it has gone through the ADF.</td>
</tr>
<tr>
<td>4 Top cover</td>
<td>Access the scanner glass.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: The scanner glass is recommended for card stock, photos, and delicate or unusually sized originals that cannot be fed through the ADF.</td>
</tr>
<tr>
<td>5 PictBridge port</td>
<td>Connect a PictBridge-enabled digital camera to the printer.</td>
</tr>
<tr>
<td>6 Paper tray</td>
<td>Load paper.</td>
</tr>
<tr>
<td>7 Paper exit tray</td>
<td>Stack paper as it exits.</td>
</tr>
<tr>
<td>8 Control panel</td>
<td>Operate the printer.</td>
</tr>
<tr>
<td></td>
<td>For more information, see “Using the control panel” on page 20.</td>
</tr>
<tr>
<td>9 Scanner unit</td>
<td>Access the print cartridges.</td>
</tr>
<tr>
<td>Use the</td>
<td>To</td>
</tr>
<tr>
<td>-----------------</td>
<td>--------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| 1 EXT port      | Connect additional devices, such as a data/fax modem, telephone, or answering machine to the printer.  
|                 | **Note:** Remove the plug to access the port.                     |
| 2 Power supply port | Connect the printer to a power source.                            |
| 3 Rear access door    | Remove paper jams.                                                 |
| 4 USB port     | Connect the printer to a computer using a USB cable.               |
| 5 LINE port    | Connect the printer to an active telephone line to send and receive faxes. The printer must be connected to this telephone line to receive incoming fax calls.  
|                 | **Note:** Do not connect additional devices to the LINE port, and do not connect a DSL (digital subscriber line), ISDN (integrated services digital network), or cable modem to the printer. |
Using the control panel buttons and menus

Using the control panel

The display shows:
- All-In-One status
- Messages
- Menus

Note: Words on the display may be abbreviated or shortened using ellipses.

<table>
<thead>
<tr>
<th>Press</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>One-Touch Dial buttons (1–5) Access any of the five programmed Speed Dial numbers.</td>
</tr>
<tr>
<td>2</td>
<td>Copy Mode Access the copy default screen and make copies. <strong>Note:</strong> The mode is selected when the button light is on.</td>
</tr>
<tr>
<td>3</td>
<td>Scan Mode Access the scan default screen and scan documents. <strong>Note:</strong> The mode is selected when the button light is on.</td>
</tr>
<tr>
<td>4</td>
<td>Fax Mode Access the fax default screen and send faxes. <strong>Note:</strong> The mode is selected when the button light is on.</td>
</tr>
<tr>
<td>5</td>
<td>Fax Auto Answer Answer all incoming calls when the button light is on. <strong>Note:</strong> For information on setting the number of rings before the machine will answer incoming calls, see “Receiving a fax automatically” on page 53.</td>
</tr>
<tr>
<td>6</td>
<td>Redial / Pause • In Fax mode, redial the last number entered. • Insert a three-second pause in the number to be dialed to wait for an outside line or get through an automated answering system. Enter a pause only when you have already begun entering the number.</td>
</tr>
<tr>
<td>7</td>
<td>Phone Book Access any of the programmed Speed Dial numbers (1–89) or Group Dial numbers (90–99).</td>
</tr>
<tr>
<td>Press</td>
<td>To</td>
</tr>
<tr>
<td>-------</td>
<td>----</td>
</tr>
<tr>
<td>1</td>
<td>Quality</td>
</tr>
</tbody>
</table>
| 2 | ▲ | • Increase a number.  
  • Enter a space between letters or numbers.  
  • Scroll through menus, submenus, or settings on the display. |
| 3 | ✓ | • Choose a menu or submenu item that appears on the display.  
  • Save settings. |
| 4 | ▼ | • Decrease a number.  
  • Delete a letter or number.  
  • Scroll through menus, submenus, or settings on the display. |
| 5 | ✗ | • Cancel a scan, copy, or print job in progress.  
  • Clear a fax number or end a fax transmission and return to the fax default screen.  
  • Exit a menu or submenu, and return to the default copy, scan, or fax screen.  
  • Clear current settings or error messages, and return to default settings. |
| 6 | ☐ | Display the Copy, Scan, or Fax menu, depending on which mode is selected. |
| 7 | ⚙ | • Return to the previous screen.  
  • Delete a letter or number. |
| 8 | Lighter/ Darker | Adjust the brightness of a copy or fax. |
### Navigating the control panel menus

1. **Press** Copy Mode, Scan Mode, or Fax Mode.
   - The copy, scan, or fax default screen appears.

2. **To** change settings, press **Menu**.

3. **Press** ▲ or ▼ repeatedly until ▶ appears next to the menu item you want.

4. **Press** ✓.

5. **Press** ▲ or ▼ repeatedly until ▶ appears next to the submenu item you want or the setting you want appears.

6. **Press** ✓.

7. If needed, press ▲ or ▼ repeatedly until the setting you want appears.

8. If you want to save the setting for future use, press ✓.

9. If needed, press ◀ repeatedly to return to the previous menus.

---

<table>
<thead>
<tr>
<th>Press</th>
<th>To</th>
</tr>
</thead>
</table>
| **1** | A keypad number or symbol | In **Copy mode**: Select the number of copies you want to make. In **Fax mode**:  
- Enter fax numbers.  
- Navigate an automated answering system.  
- Select letters when creating a Speed Dial list.  
- Type numbers to enter or edit the date and time shown on the display. |
| **2** | Start Color | Start a color copy or scan job, depending on which mode is selected. |
| **3** | Start Black | Start a black-and-white copy, scan, or fax job, depending on which mode is selected. |
| **4** | Power |  
- Turn the printer on and off.  
- Stop the print, copy, fax, or scan process. |
Using the Copy menu

To access and navigate the Copy menu:

1. From the control panel, press **Copy Mode**.
   The copy default screen appears.

2. If you do not want to change a setting, press **Start Color** or **Start Black**.

3. If you want to change a setting, press  

4. Press ▲ or ▼ repeatedly until ○ appears next to the menu item you want.

5. Press ✓.

6. Press ▲ or ▼ repeatedly until ○ appears next to the submenu item or setting you want.

7. Press ✓.

8. If needed, press ▲ or ▼ repeatedly until ○ appears next to the setting you want.

9. If you want to save the setting for future use, press ✓.

10. Press **Start Color** or **Start Black**.

   **Note:** If needed, press  repeatedly to return to the previous menus.

<table>
<thead>
<tr>
<th>Use this</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number-Copies</td>
<td>Specify how many copies to print.</td>
</tr>
<tr>
<td>Resize</td>
<td>Specify the percentage for enlarging or reducing an image copy.</td>
</tr>
<tr>
<td>Paper Size</td>
<td>Specify the size of the paper loaded.</td>
</tr>
<tr>
<td>Repeat Image</td>
<td>Choose how many copies of an image to print on a page.</td>
</tr>
<tr>
<td>Collate</td>
<td>Collate copies as they exit.</td>
</tr>
<tr>
<td>N-Up</td>
<td>Choose how many pages to print on a page.</td>
</tr>
<tr>
<td>More Settings</td>
<td>Specify the size and type of the original document.</td>
</tr>
<tr>
<td>Maintenance</td>
<td>• View ink levels.</td>
</tr>
<tr>
<td></td>
<td>• Clean cartridges.</td>
</tr>
<tr>
<td></td>
<td>• Align cartridges.</td>
</tr>
<tr>
<td></td>
<td>• Print a test page.</td>
</tr>
<tr>
<td>Device Setup</td>
<td>Customize printer settings.</td>
</tr>
<tr>
<td>Color</td>
<td>Adjust the color intensity.</td>
</tr>
</tbody>
</table>
**Using the Scan menu**

To access and navigate the Scan menu:

1. From the control panel, press **Scan Mode**.
   
   The scan default screen appears.

2. Press ▲ or ▼ repeatedly until the scan destination you want appears.

3. If you do not want to change a setting, press **Start Color** or **Start Black**.

4. If you want to change a setting, press □.

5. Press ▲ or ▼ repeatedly until ▶ appears next to the menu item you want.

6. Press ✓.

7. Press ▲ or ▼ repeatedly until ▶ appears next to the submenu item you want or the setting you want appears.

8. Press ✓.

9. If needed, press ▲ or ▼ repeatedly until ▶ appears next to the setting you want.

10. If you want to save the setting for future use, press □.

11. Press **Start Color** or **Start Black**.

**Note:** If needed, press ↪ repeatedly to return to the previous menus.

<table>
<thead>
<tr>
<th>Use this</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original Size</td>
<td>Specify the size of the original.</td>
</tr>
<tr>
<td>Maintenance</td>
<td>• View ink levels.</td>
</tr>
<tr>
<td></td>
<td>• Clean cartridges.</td>
</tr>
<tr>
<td></td>
<td>• Align cartridges.</td>
</tr>
<tr>
<td></td>
<td>• Print a test page.</td>
</tr>
<tr>
<td>Device Setup</td>
<td>Customize printer settings.</td>
</tr>
</tbody>
</table>

**Using the Fax menu**

To access and navigate the Fax menu:

1. From the control panel, press **Fax Mode**.
   
   The fax default screen appears.

2. If you do not want to change a setting, enter the fax number and press **Start Black**.

3. If you want to change a setting, press □.

4. Press ▲ or ▼ repeatedly until ▶ appears next to the menu item you want.

5. Press ✓.

6. Press ▲ or ▼ repeatedly until ▶ appears next to the submenu item you want or the setting you want appears.
Press ☑.

If needed, press ▲ or ▼ repeatedly until ☑ appears next to the setting you want.

If you want to save the setting for future use, press ☑.

Press **Start Black**.

**Note:** If needed, press ↪ repeatedly to return to the previous menus.

<table>
<thead>
<tr>
<th>Use this</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ringer Volume</td>
<td>Modify the volume.</td>
</tr>
<tr>
<td>On Hook Dial</td>
<td>Dial a telephone number while listening to the call through a speaker on the printer. This is useful when you must navigate an automated answering system before sending your fax. <strong>Note:</strong> For more information, see “Sending a fax while listening to a call (On Hook Dial)” on page 52.</td>
</tr>
<tr>
<td>Fax Reports</td>
<td>Print fax history or transmission status reports.</td>
</tr>
<tr>
<td>Delay Fax</td>
<td>Enter a specific time to send a fax. <strong>Note:</strong> Make sure the date and time are entered correctly before setting a specific time to send a fax.</td>
</tr>
<tr>
<td>Phone Books</td>
<td>Add, edit, and print names and fax numbers of individuals or groups.</td>
</tr>
<tr>
<td>Block Faxes</td>
<td>Block faxes from the numbers you specify.</td>
</tr>
<tr>
<td>Send Setup</td>
<td>Customize settings for sending a fax.</td>
</tr>
<tr>
<td>Receive (Recv.) Setup</td>
<td>Customize settings for receiving a fax.</td>
</tr>
<tr>
<td>Maintenance</td>
<td>• View ink levels.</td>
</tr>
<tr>
<td></td>
<td>• Clean cartridges.</td>
</tr>
<tr>
<td></td>
<td>• Align cartridges.</td>
</tr>
<tr>
<td></td>
<td>• Print a test page.</td>
</tr>
<tr>
<td>Device Setup</td>
<td>Customize printer settings.</td>
</tr>
</tbody>
</table>
Learning about the software

Using the printer software

<table>
<thead>
<tr>
<th>Use this</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Productivity Suite</td>
<td>Open the component necessary for you to complete a task.</td>
</tr>
<tr>
<td>The All-In-One Center</td>
<td>Scan, copy, print, and fax.</td>
</tr>
<tr>
<td>The Solution Center</td>
<td>Find troubleshooting, maintenance, and cartridge ordering information.</td>
</tr>
<tr>
<td>Print Properties</td>
<td>Select the best print settings for the document you are printing.</td>
</tr>
<tr>
<td>The Photo Editor</td>
<td>Edit photos and graphics.</td>
</tr>
<tr>
<td>Fast Pics</td>
<td>Transfer photos from a PictBridge-enabled digital camera to the computer.</td>
</tr>
<tr>
<td>The Fax Setup Utility</td>
<td>Adjust fax settings.</td>
</tr>
</tbody>
</table>

Using the Productivity Suite

To open the Productivity Suite software, use one of these methods:

<table>
<thead>
<tr>
<th>Method 1</th>
<th>Method 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the desktop, double-click the Productivity Suite icon.</td>
<td>1  Click Start → Programs or All Programs → Lexmark 7300 Series.</td>
</tr>
<tr>
<td></td>
<td>2  Select Productivity Suite.</td>
</tr>
</tbody>
</table>

Click the Productivity Suite icon for the task you want to complete.

<table>
<thead>
<tr>
<th>Click</th>
<th>To</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage Documents</td>
<td>Organize, search for, or print documents. Send documents to other people, or open them with various programs.</td>
<td></td>
</tr>
<tr>
<td>Manage Photos</td>
<td>Organize or print photos in various layouts. Send photos to other people, or open them with various programs.</td>
<td></td>
</tr>
<tr>
<td>Visit Lexmark Online</td>
<td>Visit our Web site.</td>
<td></td>
</tr>
</tbody>
</table>
Using the All-In-One Center

Opening the All-In-One Center

Use the All-In-One Center software to scan, copy, and fax documents, or to print saved photos.

To open the All-In-One Center, use one of these methods:

Method 1
From the desktop, double-click the Productivity Suite icon, and then click Scan or Copy.

Method 2
1. Click Start → Programs or All Programs → Lexmark 7300 Series.
2. Select All-In-One Center.
**Using the Scanning & Copying tab**

Use the Scanning & Copying tab to perform scanning and copying tasks, to select a task from Productivity Tools, or to preview an image.

<table>
<thead>
<tr>
<th>From this section</th>
<th>You can</th>
</tr>
</thead>
</table>
| Scan              | • Select a program to send a scanned image to.  
|                   | • Select what type of image is being scanned.  
|                   | • Select the scan quality.  
|                   | **Note:** Click **See More Scan Settings** to view all settings. |
| Copy              | • Select the quantity and color of copies.  
|                   | • Select a quality setting for copies.  
|                   | • Select a blank paper size.  
|                   | • Select the size of the original document.  
|                   | • Lighten or darken copies.  
|                   | • Enlarge or reduce copies.  
|                   | **Note:** Click **See More Copy Settings** to view all settings. |
| Productivity Tools| • Print  
|                   | – Repeat an image several times on one page.  
|                   | – Enlarge or reduce an image.  
|                   | – Print an image as a multiple-page poster.  
|                   | – Print more than one page on a sheet of paper.  
|                   | • Share  
|                   | – Fax an image or document.  
|                   | – E-mail an image or document.  
|                   | • Save  
|                   | – Save an image on the computer.  
|                   | – MagiChop—Save multiple photos.  
|                   | – Scan and save to PDF format.  
|                   | • Edit  
|                   | – Edit text found in a scanned document (OCR).  
|                   | – Modify an image with a photo editor.  
| Preview           | • Select a region of the previewed image to scan or copy.  
|                   | • View an image of what will be printed or copied. |

**Note:** For more information about using the Scanning & Copying tab, click **Help** in the top center of the screen.
**Using the Saved Images tab**

Use the Saved Images tab to perform tasks with images that are saved on the computer.

<table>
<thead>
<tr>
<th>From this section</th>
<th>You can</th>
</tr>
</thead>
</table>
| Preview          | • Show or create folders.  
                  | • Preview and select images.  
                  | • Rename, delete, or edit selected images.  |
| Open With        | Select where to send the saved images.  |
| Photo Prints     | Click **Show More Printing Options** to view and adjust the print settings. You can:  
                  | • Select the quantity and color of copies.  
                  | • Select a quality setting for copies.  
                  | • Lighten or darken copies.  
                  | • Enlarge or reduce copies.  |
| **Note:** Click **Next** to select and print photos in standard sizes.  |
| Productivity Tools | • Print  
                  |   • Print an album page with various photo sizes.  
                  |   • Enlarge or reduce an image.  
                  |   • Print an image as a multiple-page poster.  
                  | • Share  
                  |   • Fax an image or document.  
                  |   • E-mail an image or document.  
                  | • Edit  
                  |   • Edit text found in a scanned document (OCR).  
                  |   • Modify an image with a photo editor.  |

**Note:** For more information about using the Saved Images tab, click **Help** in the top center of the screen.

**Using the Maintain/Troubleshoot link**

The Maintain/Troubleshoot link provides you with direct links to the Solution Center and the Fax Setup Utility.

1. Click **Start → Programs** or **All Programs → Lexmark 7300 Series**.
2. Select **All-In-One Center**.
3. Click **Maintain/Troubleshoot**.
4. Select from these topics:  
   • Maintain or fix quality problems  
   • Troubleshoot problems  
   • Device status and ink levels  
   • More printing ideas and how to's  
   • Contact information  
   • Advanced (Voice and communication options)
Using the Solution Center

The Solution Center provides help, as well as information about the printer status and ink levels. There are two ways of opening the Solution Center.

<table>
<thead>
<tr>
<th>Method 1</th>
<th>Method 2</th>
</tr>
</thead>
</table>
| From the desktop, double-click the Productivity Suite icon, and then click the Maintain/Troubleshoot button. | 1 Click Start → Programs or All Programs → Lexmark 7300 Series.  
2 Select Solution Center. |

The Solution Center consists of six tabs:

<table>
<thead>
<tr>
<th>From this tab</th>
<th>You can</th>
</tr>
</thead>
</table>
| Printer Status (Main dialog) | • View the status of the printer. For example, while printing, the status of the printer is Busy Printing.  
• View the type of paper detected in the printer.  
• View the ink levels of the print cartridges. |
| How To | Learn how to:  
• Scan, copy, fax, and print.  
• Find and change settings.  
• Use basic features.  
• Print projects such as banners, photos, envelopes, cards, iron-on transfers, and transparencies.  
• Find the printable User's Guide. |
| Troubleshooting | • Learn tips about the current status.  
• Solve printer problems. |
| Maintenance | • Install a print cartridge.  
**Note:** Wait until scanning is complete before installing new print cartridges.  
• View shopping options for new cartridges.  
• Print a test page.  
• Clean to fix horizontal streaks.  
• Align to fix blurry edges.  
• Troubleshoot other ink problems. |
| Contact Information | Learn how to contact us by telephone, e-mail, or on the World Wide Web. |
From this tab | You can
--- | ---
Advanced | • Change the appearance of the Printing Status window.
| • Turn printing voice notification on or off.
| • Change network printing settings.
| • Share information with us regarding how you use the printer.
| • Obtain software version information.

**Note:** For more information, click **Help** in the lower right corner of the screen.

### Using Print Properties

#### Opening Print Properties

Print Properties is the software that controls the printing function when the printer is connected to a computer. You can change the settings in Print Properties based on the type of project you want to create. You can open Print Properties from almost any program:

1. With a document open, click **File ➔ Print**.
2. From the Print dialog, click **Properties, Preferences, Options, or Setup**.

#### Using the Save Settings menu

From the “Save Settings” menu, you can name and save the current Print Properties settings for future use. You can save up to five custom settings.

#### Using the I Want To menu

The “I Want To” menu contains a variety of task wizards (printing a photo, an envelope, a banner, a poster, or printing on both sides of the paper) to help you select the correct print settings for a project.

#### Using the Options menu

Use the “Options” menu to make changes to the Quality Options, Layout Options, and Printing Status Options settings. For more information on these settings, open the tab dialog from the menu, and then click the **Help** button on the dialog.

The “Options” menu also provides direct links to different parts of the Solution Center as well as software version information.
Using the Print Properties tabs

All of the print settings are on the three main tabs of the Print Properties software: Quality/Copies, Paper Setup, and Print Layout.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quality/Copies</td>
<td>• Select a Quality/Speed setting.</td>
</tr>
<tr>
<td></td>
<td>• Select a Paper Type.</td>
</tr>
<tr>
<td></td>
<td>• Customize how the printer prints several copies of a single print job:</td>
</tr>
<tr>
<td></td>
<td>collated or normal.</td>
</tr>
<tr>
<td></td>
<td>• Choose Automatic Image Sharpening.</td>
</tr>
<tr>
<td></td>
<td>• Choose to print color images in black and white.</td>
</tr>
<tr>
<td></td>
<td>• Choose to have the last page printed first.</td>
</tr>
<tr>
<td>Paper Setup</td>
<td>• Specify the size of paper loaded.</td>
</tr>
<tr>
<td></td>
<td>• Select the orientation of the document on the printed page: portrait or landscape.</td>
</tr>
<tr>
<td>Print Layout</td>
<td>• Select the layout you want to print.</td>
</tr>
<tr>
<td></td>
<td>• Choose to print on both sides of the paper, and select a duplexing preference.</td>
</tr>
</tbody>
</table>

**Note:** For more information about these settings, right-click a setting on the screen, and then select What's This?

Using the Photo Editor

Use the Photo Editor software to edit graphics or photos.

1. Click **Start → Programs or All Programs → Lexmark 7300 Series**.
2. Select **Photo Editor**.
3. Click **File → Open** to select the image you want to edit.
4. Edit the image with the available tools.
   **Notes:**
   • You can edit only one image at a time.
   • Move the mouse pointer over the tool for a description.
5. Click **File → Save as**.
6. Enter a file name and file type, and then click **Save**.

<table>
<thead>
<tr>
<th>From this section</th>
<th>You can</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quick Fixes</td>
<td>• Remove the red-eye effect caused by light reflection.</td>
</tr>
<tr>
<td></td>
<td>• Fix the photo with one click.</td>
</tr>
<tr>
<td></td>
<td>• Crop the image.</td>
</tr>
<tr>
<td></td>
<td>• Rotate the image.</td>
</tr>
<tr>
<td></td>
<td>• Flip the image.</td>
</tr>
<tr>
<td>From this section</td>
<td>You can</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Image Adjust</td>
<td>• Adjust the color depth.</td>
</tr>
<tr>
<td></td>
<td>• Adjust the color balance.</td>
</tr>
<tr>
<td></td>
<td>• Colorize the image.</td>
</tr>
<tr>
<td></td>
<td>• Colorize the image to sepia tones.</td>
</tr>
<tr>
<td></td>
<td>• Adjust the Brightness/Contrast.</td>
</tr>
<tr>
<td></td>
<td>• Adjust the blur.</td>
</tr>
<tr>
<td></td>
<td>• Adjust the sharpness.</td>
</tr>
<tr>
<td></td>
<td>• Despeckle (blur) the image to remove dust and scratches.</td>
</tr>
<tr>
<td></td>
<td>• Adjust the exposure.</td>
</tr>
<tr>
<td></td>
<td>• Adjust the color level.</td>
</tr>
<tr>
<td>Image Size</td>
<td>• Change the units of measurement.</td>
</tr>
<tr>
<td></td>
<td>• Resize the image.</td>
</tr>
<tr>
<td></td>
<td>• Crop the image.</td>
</tr>
<tr>
<td>Drawing Tools</td>
<td>• Select an area by dragging a box around it. Use this for text box placement and cutting and copying areas.</td>
</tr>
<tr>
<td></td>
<td>• Add text.</td>
</tr>
<tr>
<td></td>
<td>• Fill pixels with color.</td>
</tr>
<tr>
<td></td>
<td>• Draw with a pencil tool.</td>
</tr>
<tr>
<td></td>
<td>• Draw with a line tool.</td>
</tr>
<tr>
<td></td>
<td>• Erase areas.</td>
</tr>
<tr>
<td></td>
<td>• Paint areas with a paintbrush tool.</td>
</tr>
<tr>
<td></td>
<td>• Pick up a color using the eyedropper.</td>
</tr>
</tbody>
</table>

**Using the Fax Setup Utility**

Use this utility to adjust how faxes are sent and received. When you save the settings, they apply to every fax you send or receive. You can also use this utility to create and edit the Speed Dial list.

1. From the desktop, double-click the **Productivity Suite** icon.
2. Click **Fax**.
3. Click **Manage fax history** or **All-In-One fax settings**.

For a list of options available from the Fax Setup Utility, see “Customizing fax settings” on page 58.
Loading paper and original documents

Loading paper

1 Make sure:
   • You use paper designed for inkjet printers.
   • The paper is not used or damaged.
   • If you are using specialty paper, you follow the instructions that came with it.
   • You do not force paper into the printer.

2 Lift the paper exit tray, and extend the center paper guide.

3 Insert paper into the paper tray.

4 Adjust the paper guides to rest against the left, right, and bottom edges of the paper.

5 Lower the paper exit tray.
6 Extend the paper exit tray stop to catch the paper as it exits.

## Loading various paper types

<table>
<thead>
<tr>
<th>Load up to</th>
<th>Make sure</th>
</tr>
</thead>
<tbody>
<tr>
<td>100 sheets of plain paper</td>
<td>The paper guides rest against the left, right, and bottom edges of the paper.</td>
</tr>
<tr>
<td>50 sheets of coated paper</td>
<td>• The glossy or coated side of the paper faces down.</td>
</tr>
<tr>
<td>50 sheets of premium paper</td>
<td>• The paper guides rest against the left, right, and bottom edges of the paper.</td>
</tr>
<tr>
<td>50 sheets of photo paper</td>
<td><strong>Note</strong>: Photos require more drying time. Remove each photo as it exits, and allow it to dry to avoid ink smudging.</td>
</tr>
<tr>
<td>50 sheets of glossy paper</td>
<td>• The letterhead side of the paper faces down.</td>
</tr>
<tr>
<td>100 sheets of letterhead paper</td>
<td>• The top of the letterhead feeds into the printer first.</td>
</tr>
<tr>
<td></td>
<td>• The paper guides rest against the left, right, and bottom edges of the paper.</td>
</tr>
<tr>
<td>Load up to</td>
<td>Make sure</td>
</tr>
<tr>
<td>------------</td>
<td>-----------</td>
</tr>
</tbody>
</table>
| 10 envelopes| • You do not load envelopes with holes, perforations, cutouts, deep embossing, metal clasps, metal folding bars, string ties, or exposed adhesive flaps into the printer.  
| | • The print side of the envelopes faces down with the flap to the left as shown.  
| | • You print the envelopes in landscape orientation.  
| | • You select the correct envelope size. If the exact envelope size is not listed, select the next biggest size. Set the left and right margins so that the envelope text will be correctly positioned on the envelope.  
| | • You load the envelopes vertically and all the way to the back of the paper tray.  
| | • The paper guides rest against the left, right, and bottom edges of the envelopes.  
| | **Note:** Envelopes require more drying time. Remove each envelope as it exits, and allow it to dry to avoid ink smudging. |
| 25 sheets of labels | • You use full label sheets. Partial sheets (with areas exposed by missing labels) may cause labels to peel off during printing, resulting in a paper jam.  
| | • The print side of the labels faces down.  
| | • The top of the labels feeds into the printer first.  
| | • The paper guides rest against the left, right, and bottom edges of the label sheets.  
| | **Note:** Labels require more drying time. Remove each sheet of labels as it exits, and allow it to dry to avoid ink smudging. |
| 50 transparencies | • The rough side of the transparencies faces down.  
| | • You remove any paper backing sheets from the transparencies before loading.  
| | • If the transparencies have a removable strip, each strip faces down toward the paper tray.  
| | • The paper guides rest against the left, right, and bottom edges of the transparencies.  
<p>| | <strong>Note:</strong> Transparencies require more drying time. Remove each transparency as it exits, and allow it to dry to avoid ink smudging. |</p>
<table>
<thead>
<tr>
<th>Load up to</th>
<th>Make sure</th>
</tr>
</thead>
</table>
| 100 sheets of custom size paper               | • The print side of the paper faces down.  
• The paper size fits within these dimensions: Width:  
  – 76–216 mm  
  – 3.0–8.5 inches  
  Length:  
  – 127–432 mm  
  – 5.0–17.0 inches  
• The paper guides rest against the left, right, and bottom edges of the paper. |
| 25 index cards, photo cards, or postcards     | • The thickness does not exceed 0.025 inches (0.635 mm).  
• The print side of the cards faces down.  
• You load the cards vertically and all the way to the back of the paper tray.  
• The paper guides rest against the left, right, and bottom edges of the cards. |

Note: Photo cards require more drying time. Remove each photo card as it exits, and allow it to dry to avoid ink smudging.
<table>
<thead>
<tr>
<th>Load up to</th>
<th>Make sure</th>
</tr>
</thead>
</table>
| 20 sheets of banner paper  | • You remove all the paper from the paper tray before loading the banner paper.  
• You tear off only the number of pages needed to print the banner.  
• The print side of the banner faces down into the paper tray with the first page of the banner on top.  
• The leading edge of the banner paper feeds into the printer.  
• The paper guides rest against the right and left edges of the paper.  
• You have selected the correct paper size for the banner in Print Properties. For more information, see “Using Print Properties” on page 31. |

**Loading original documents into the ADF**

You can load up to 50 sheets of an original document into the ADF for scanning, copying, and faxing. You can load A4, letter, or legal size paper into the ADF.

1. Load an original document text side up into the ADF.

   ![ADF Image]

   **Note:** Do not load postcards, photos, small items, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.

2. Adjust the paper guide on the ADF against the edges of the paper.
### ADF paper capacity

<table>
<thead>
<tr>
<th>Load up to</th>
<th>Make sure</th>
</tr>
</thead>
<tbody>
<tr>
<td>50 sheets of:</td>
<td>• The document is loaded text side up.</td>
</tr>
<tr>
<td>• Letter paper</td>
<td>• The paper guide is against the edge of the paper.</td>
</tr>
<tr>
<td>• A4 paper</td>
<td></td>
</tr>
<tr>
<td>• Legal size paper</td>
<td></td>
</tr>
<tr>
<td>50 sheets of:</td>
<td></td>
</tr>
<tr>
<td>• Custom paper</td>
<td>• The document is loaded text side up.</td>
</tr>
<tr>
<td>• Pre-punched paper</td>
<td>• The paper guide is against the edge of the paper.</td>
</tr>
<tr>
<td>• Reinforced edge copier paper</td>
<td>• The paper size fits within these dimensions:</td>
</tr>
<tr>
<td>• Preprinted forms</td>
<td>- 210.0 mm–215.9 mm</td>
</tr>
<tr>
<td>• Letterhead paper</td>
<td>- 8.27 in.–8.5 in.</td>
</tr>
<tr>
<td></td>
<td>- 279.4 mm–355.6 mm</td>
</tr>
<tr>
<td></td>
<td>- 11.0 in.–14.0 in.</td>
</tr>
<tr>
<td></td>
<td>• You allow preprinted media to dry thoroughly before loading into the ADF.</td>
</tr>
<tr>
<td></td>
<td>• You do not use media printed with metallic ink particles.</td>
</tr>
<tr>
<td></td>
<td>• You avoid embossed designs.</td>
</tr>
</tbody>
</table>

### Loading original documents on the scanner glass

You can scan and then print photos, text documents, magazine articles, newspapers, and other publications. You can scan a document for faxing. You can also scan three-dimensional objects for use in catalogs, brochures, or product fliers.

**Note:** Place photos, postcards, small items, thin items (such as magazine clippings), and three-dimensional objects on the scanner glass instead of in the ADF.

1. Make sure the computer and the printer are on.
2. Open the top cover.
3 Place the original document face down on the scanner glass in the upper left corner.

**Note:** Photos should be loaded as shown.

4 Close the top cover to avoid dark edges on the scanned image.
Printing

Printing a document

1 Load paper.
2 With a document open, click File → Print.
3 Click Properties, Preferences, Options, or Setup.
4 Adjust the settings.
5 Click OK.
6 Click OK or Print.

Printing collated copies

If you print multiple copies of a document, you can choose to print each copy as a set (collated) or to print the copies as groups of pages (not collated).

<table>
<thead>
<tr>
<th>Collated</th>
<th>Not collated</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Collated example" /></td>
<td><img src="image" alt="Not collated example" /></td>
</tr>
</tbody>
</table>

1 Load paper.
2 With a document open, click File → Print.
3 Click Properties, Preferences, Options, or Setup.
4 From the Quality/Copies tab, select the number of copies to print.
5 Select the Collate Copies check box.
6 Select the Print Last Page First check box.
7 Click OK.
8 Click OK or Print.

Printing the last page first (reverse page order)

1 Load paper.
2 With a document open, click File → Print.
3 Click Properties, Preferences, Options, or Setup.
4 From the Quality/Copies tab, select Print Last Page First.
5 Click OK.
6 Click OK or Print.
Printing transparencies

1. Load transparencies.
2. With a document open, click File → Print.
3. Click OK or Print.

Note: To prevent smudging, remove each transparency as it exits, and let it dry before stacking. Transparencies may require up to 15 minutes to dry.

Printing envelopes

1. Load envelopes.
2. From the software application, click File → Print.
3. Click Properties, Preferences, Options, or Setup.
4. From the “I Want To” menu, select Print on an envelope.
5. From the Envelope Size list, select the envelope size loaded.
6. Select Portrait or Landscape orientation.

Notes:
- Most envelopes use landscape orientation.
- Make sure the same orientation is also selected in the software application.

7. Click OK.
8. Click OK.
9. Click OK or Print.

Printing multiple pages on one sheet

1. Load paper.
2. With a document open, click File → Print.
3. Click Properties, Preferences, Options, or Setup.
4 From the Print Layout tab, select N-up.

5 Select the number of pages to print on each page.

6 If you want each page image to be surrounded by a border, select Print Page Borders.

7 Click OK.

8 Click OK or Print.

**Printing cards**

1 Load greeting cards, index cards, or postcards.

2 From the software application, click File → Print.

3 Click Properties, Preferences, Options, or Setup.

4 Select a Quality/Speed setting.
   - Select Best for photos and greeting cards and Normal for other types of cards.

5 Select the Paper Setup tab.

6 Select Paper.

7 From the Paper Size list, select a card size.

8 Click OK.

9 Click OK or Print.

**Notes:**

- To avoid paper jams, do not force the cards into the printer.
- To prevent smudging, remove each card as it exits, and let it dry before stacking.
Copying

<table>
<thead>
<tr>
<th>ADF</th>
<th>Scanner glass</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="ADF" /></td>
<td><img src="image2.png" alt="Scanner glass" /></td>
</tr>
</tbody>
</table>

Use the ADF for multiple-page A4, letter or legal size documents.

Use the scanner glass for single pages, small items (such as postcards or photos), or thin media (such as magazine clippings).

**Note:** If you want to customize copy settings, see “Using the Copy menu” on page 23.

**Making a copy**

1. Load paper.

2. Load an original document faceup into the ADF or facedown on the scanner glass.

   **Note:** Do not load postcards, photos, small items, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.

3. From the control panel, press **Copy Mode**.

4. Press **Start Color** or **Start Black**.

**Collating copies**

If you print multiple copies of a document, you can choose to print each copy as a set (collated) or to print the copies as groups of pages (not collated).

<table>
<thead>
<tr>
<th>Collated</th>
<th>Not collated</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image3.png" alt="Collated" /></td>
<td><img src="image4.png" alt="Not collated" /></td>
</tr>
</tbody>
</table>

1. Load paper.

2. Load an original document faceup into the ADF.

3. From the control panel, press **Copy Mode**.
4 Press □.

5 Press ▲ or ▼ repeatedly until ▶ appears next to Collate.

6 Press ✓.

7 Press ▲ or ▼ repeatedly until on appears.

8 Press ✓.

9 Press ▲ or ▼ repeatedly until the number of copies you want to print appears.

10 Press ✓.

11 Press Start Color or Start Black.

### Repeating an image on one page

You can print the same image multiple times on one sheet of paper. This option is helpful in creating labels, decals, flyers, and handouts.

1 Load paper.

   Note: If you are copying photos, use photo or glossy paper, with the glossy or coated side facing down.

2 Load an original document facedown on the scanner glass.

3 From the control panel, press Copy Mode.

4 Press □.

5 Press ▲ or ▼ repeatedly until ▶ appears next to Repeat Image.

6 Press ✓.

7 Press ▲ or ▼ repeatedly until the number of images you want to print on one page appears.

8 Press Start Color or Start Black.

### Enlarging or reducing an image

1 Load paper.

   Note: If you are copying photos, use photo or glossy paper, with the glossy or coated side facing down.

2 Load an original document faceup into the ADF or facedown on the scanner glass.

   Note: Do not load postcards, photos, small items, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.

3 From the control panel, press Copy Mode.

4 Press □.

5 Press ▲ or ▼ repeatedly until ▶ appears next to Resize.

6 Press ✓.
7 Press ▲ or ▼ repeatedly until the setting you want appears.

8 Press Start Color or Start Black.
Scanning

ADF

Use the ADF for multiple-page A4, letter, or legal size documents.

Scanner glass

Use the scanner glass for single pages, small items (such as postcards or photos), or thin media (such as magazine clippings).

Note: If you want to customize scan settings, see “Using the Scan menu” on page 24.

Scanning a document

1. Make sure the printer is connected to a computer, and both the printer and the computer are on.
2. Load an original document faceup into the ADF or facedown on the scanner glass.
3. Press Scan Mode.
4. Press ▲ or ▼ repeatedly until the destination to which you want to scan appears.
5. Press Start Color or Start Black.
6. To scan multiple pages from the scanner glass, place successive pages face down on the scanner glass and press Start Color or Start Black.

Scanning documents or images for e-mailing

1. Make sure the printer is connected to a computer, and both the printer and the computer are on.
2. Load an original document faceup into the ADF or facedown on the scanner glass.
   Note: Do not load postcards, photos, small items, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.
3. From the control panel, press Scan Mode.
4. Press ▲ or ▼ repeatedly until Email appears.
5. Press Start Color or Start Black.
6. Follow the instructions on the computer screen.
Scanning text for editing

Use the Optical Character Recognition (OCR) software feature to turn scanned images into text you can edit with a word-processing application.

1 Make sure:
   - The printer is connected to a computer, and both the printer and the computer are on.
   - ABBYY Fine Reader is installed.

2 Load an original document faceup into the ADF or facedown on the scanner glass.
   **Note:** Do not load postcards, photos, small items, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.

3 Double-click the **Productivity Suite** icon.

4 Click **Scan & Edit Text (OCR)**.

5 Click **Preview Now**.

6 Select a word-processing program to edit the text.

7 Click **Send Now**.

8 Edit and save the document.

Scanning images for editing

1 Make sure the printer is connected to a computer, and both the printer and the computer are on.

2 Load an original document faceup into the ADF or facedown on the scanner glass.
   **Note:** Do not load postcards, photos, small items, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.

3 From the desktop, double-click the **Productivity Suite** icon.

4 Click **Scan**.

5 From the “Send scanned image to” menu, select a graphics program to edit the images.

6 Click **Scan Now**.
   When the image finishes processing, it opens in the program you selected.

7 Edit the image using the tools available in the graphics program. For more information, see the documentation that came with the graphics program.

Scanning clear images from magazines or newspapers

Descreening helps to remove wavy patterns from images scanned from magazines or newspapers.

1 Make sure the printer is connected to a computer, and both the printer and the computer are on.

2 Load an original document faceup into the ADF or facedown on the scanner glass.
   **Note:** Do not load postcards, photos, small items, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.

3 From the desktop, double-click the **Productivity Suite** icon.
4 Click **Scan**.

5 Click **Display Advanced Scan Settings**.

6 Select the **Image Patterns** tab.

7 Select the **Remove image patterns from magazine/newspaper (descreen)** check box.

8 From the “What is being scanned?” menu, select **Magazine** or **Newspaper**.

9 Click **OK**.

10 From the “Send scanned image to” menu, select the destination to which you want to send the scan.

11 Click **Scan Now**.

**Scanning to a computer over a network**

1 Make sure:
   - The printer is connected to the network through a print server, and the printer, print server, and computer receiving the scan are on.
   - The printer is configured to scan over a network (Direct IP Printing).

2 Load an original document faceup into the ADF or facedown on the scanner glass.

   **Note:** Do not load postcards, photos, small items, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.

3 From the control panel, press **Scan Mode**.

4 Press ▲ or ▼ repeatedly until the computer to which you want to scan is highlighted.

5 If you set a PIN during network setup, you will be prompted to enter it. After you enter it, press ✓.

6 Press ▲ or ▼ repeatedly until the scan destination you want appears.

7 Press **Start Color** or **Start Black**.
Faxing

<table>
<thead>
<tr>
<th>ADF</th>
<th>Scanner glass</th>
</tr>
</thead>
<tbody>
<tr>
<td>![ADF Image] Use the ADF for multiple-page A4, letter, or legal size documents.</td>
<td>![Scanner glass Image] Use the scanner glass for single pages, small items (such as postcards or photos), or thin media (such as magazine clippings).</td>
</tr>
</tbody>
</table>

**Note:** If you want to customize fax settings:
- Using the control panel, see “Using the Fax menu” on page 24.
- Using the computer, see “Customizing settings using the Fax Setup Utility” on page 58.

**Sending a fax**

**Entering a fax number**

1. From the control panel, press **Fax Mode**.
2. Enter a fax number using:

<table>
<thead>
<tr>
<th>The text box</th>
<th>Enter a fax number using the keypad.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Notes:</strong></td>
<td></td>
</tr>
<tr>
<td>• You can include a calling card number as part of the fax number.</td>
<td></td>
</tr>
<tr>
<td>• Enter a maximum of 64 digits in a fax number.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Quick Dial</th>
<th>Press <strong>Quick Dial 1, 2, 3, 4, or 5</strong>.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Speed Dial or Group Dial</th>
<th>a Press <strong>Phone Book</strong>.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>b Enter Speed Dial and/or Group Dial numbers.</td>
</tr>
<tr>
<td></td>
<td>• Press ▲ or ▼ repeatedly until the Speed Dial or Group Dial number you want appears.</td>
</tr>
<tr>
<td></td>
<td>• Use the keypad to enter the number of the Speed Dial entry (1–89) or Group Dial entry (90–99).</td>
</tr>
</tbody>
</table>
3 Press ✅.

4 If you want to send a fax to a group of numbers (broadcast fax), repeat step 2 and step 3, using any combination of the above methods, until a maximum of 30 fax numbers have been entered.

Sending a fax using the control panel

1 Make sure the printer is on.

2 Load an original document faceup into the ADF or facedown on the scanner glass.
   Note: Do not load postcards, photos, small items, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.

3 From the control panel, press Fax Mode.

4 Enter a fax number; press Quick Dial 1, 2, 3, 4, or 5; or press Phone Book to select a number from the Speed Dial or Group Dial list. For more information, see “Entering a fax number” on page 50.
   Notes:
   • To set the Quick Dial buttons, see “Setting up Quick Dial buttons using the control panel” on page 55 and “Setting up Quick Dial buttons using the computer” on page 55.
   • To set up Speed Dial, see “Setting up Speed Dial numbers” on page 55.

5 If you want to send a fax to a group of numbers (broadcast fax):
   a Press ✅.
   b Repeat step 4 until a maximum of 30 fax numbers have been entered.

6 Press Start Black.
   The printer scans the document and sends the fax to the number you entered.

Sending a fax using the computer

You can scan a document to the computer and then fax it to someone using the software.

1 Make sure the printer is connected to a computer, and both the printer and the computer are on.

2 Load an original document faceup into the ADF or facedown on the scanner glass.
   Note: Do not load postcards, photos, small items, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.

3 From the desktop, double-click the Productivity Suite icon.

4 Click Fax.

5 Click Fax a document in the All-in-One.

6 Follow the instructions on the computer screen to complete the task.
**Sending a broadcast fax at a scheduled time**

You can send a fax to a combination of up to 30 people or groups at a time you choose.

1. Load an original document faceup into the ADF or facedown on the scanner glass.
   
   **Note:** Do not load postcards, photos, small items, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.

2. From the control panel, press **Fax Mode**.

3. Press 

4. Press ▲ or ▼ repeatedly until **Delay Fax** appears.

5. Press ✔.

   ✔ appears next to **Delay Current**.

6. Press ✔.

7. Enter the time you want to send the fax.

8. Press ✔.

9. To select AM or PM, press ▲ or ▼ repeatedly until the setting you want appears.

10. Press ✔ to save your settings.

11. Enter a fax number; press **Quick Dial 1, 2, 3, 4, or 5**; or press **Phone Book** to select a number from the Speed Dial or Group Dial list. For more information, see “Entering a fax number” on page 50.

12. Repeat step 11 until a maximum of 30 fax numbers have been entered.

13. Press **Start Black**.

**Note:** At the designated time, the fax numbers are dialed and the fax is sent to all of the designated fax numbers. If the fax transmission is unsuccessful to any of the numbers on the broadcast list, the unsuccessful numbers will be dialed again.

**Sending a fax while listening to a call (On Hook Dial)**

The manual dialing feature lets you dial a telephone number while listening to the call through a speaker on the printer. It is useful when you must navigate an automated answering system or enter a calling card number before sending your fax.

1. From the control panel, press **Fax Mode**.

2. Press 

3. Press ▲ or ▼ repeatedly until **On Hook Dial** appears.

4. Press ✔ twice.

   You can now hear the dial tone of the telephone line.
Enter a fax number; press Quick Dial 1, 2, 3, 4, or 5; or press Phone Book to select a number from the Speed Dial or Group Dial list. For more information, see “Entering a fax number” on page 50.

**Note:** Press the keypad numbers to use an automated answering system.

Press Start Black.

**Receiving a fax**

**Receiving a fax automatically**

1. Make sure the Fax Auto Answer light is on.

2. To set the number of telephone rings before the printer automatically receives faxes, see “Setting the number of rings before receiving a fax automatically” on page 57.

**Receiving a fax with an answering machine**

**Note:** You must set up the equipment as shown in “Connecting to an answering machine” on page 14.

To receive a fax with an answering machine connected to the printer:

1. Make sure the Fax Auto Answer light is on.

2. Set the answering machine to answer incoming calls before the printer does.

   - For example, if you set the answering machine to answer calls after three rings, set the printer to answer calls after five rings.

3. To set the number of telephone rings before the printer automatically receives faxes, see “Setting the number of rings before receiving a fax automatically” on page 57.

**Receiving a fax manually**

1. Make sure the Fax Auto Answer light is off.

2. To receive the fax:

   - Press Start Black
   - Or
   - Press *9* on the telephone after you answer it and hear fax tones

3. Hang up the telephone. The printer receives the fax.

**Using Caller ID**

Caller ID is a service provided by some telephone companies that identifies the telephone number (and possibly the name) of the person who is calling. If you subscribe to this service, it works with the printer. When you receive a fax, the telephone number of the person who is sending you the fax appears on the display.

**Note:** Caller ID is available only in some countries and regions.
Forwarding faxes

Use the fax forwarding feature if you are going to be away, but still want to receive your faxes. There are three fax forwarding settings:

- **Off**—(Default).
- **Forward**—The printer sends the fax to the designated fax number.
- **Print & Forward**—The printer prints the fax and then sends it to the designated fax number.

To set up fax forwarding:

1. From the control panel, press **Fax Mode**.
2. Press ✉️.
3. Press ▲ or ▼ repeatedly until **Recv. Setup** appears.
4. Press ✓.
5. Press ▲ or ▼ repeatedly until **Fax Forward** appears.
6. Press ✓.
7. Press ▲ or ▼ repeatedly until the setting you want appears.
8. Press ✓.
9. Enter the number to which you want to forward the fax.
10. Press ✓ to save the setting.
   
   **Note:** If you select Forward or Print & Forward, **Forward** will appear in the lower left corner of the fax default menu. To view the selected setting, press 🔄.

Printing fax activity reports

1. From the control panel, press **Fax Mode**.
2. Press ✉️.
3. Press ▲ or ▼ repeatedly until **Fax Reports** appears.
4. Press ✓.
5. Press ▲ or ▼ repeatedly until the type of report you want to print appears.
6. Press ✓ to print the report.
Setting up Quick Dial buttons and Speed Dial numbers

Setting up Quick Dial buttons using the control panel

1. From the control panel, press Fax Mode.
2. Enter a fax number.
   
   Notes:
   
   • You can include a calling card number as part of the fax number.
   • Enter a maximum of 64 digits in a fax number.
3. Hold down an empty Quick Dial button for two seconds.
4. To program additional Quick Dial buttons, repeat step 2 through step 3.
   
   Note: You can also program any empty Quick Dial button whenever you are prompted to enter a fax number.

Setting up Quick Dial buttons using the computer

1. Create the first five Speed Dial numbers, which become Quick Dial 1, 2, 3, 4, and 5.
2. If you need more information, see “Setting up Speed Dial numbers” on page 55.

Setting up Speed Dial numbers

The Quick Dial buttons are automatically programmed when you program the first five Speed Dial numbers. The first five numbers assigned become Quick Dial 1, 2, 3, 4, and 5.

1. From the desktop, double-click the Productivity Suite icon.
2. Click Fax.
3. Click Manage fax history or All-In-One fax settings.
4. Click the Speed Dial tab.
5. To add a fax number to your Speed Dial list:
   a. Click the next empty line in the list.
   b. Enter a fax number.
   c. Place the cursor in the Contact Name field.
   d. Enter a contact name.
   e. Repeat step a through step d as necessary using lines 2–89.
6. To add a fax group:
   a. Scroll down to line 90.
      A new entry box appears.
   b. Click on the next empty line in the list.
   c. Enter up to 30 fax numbers for the group.
   d. Place the cursor in the Contact Name field.
   e. Enter a contact name.
   f. Repeat step b through step e to add additional groups using lines 91–99 as necessary.
7. Click OK to save the entries.
Notes:
- You can include a calling card number as part of the fax number.
- Enter a maximum of 64 digits in a fax number.

Using the Phone Book
The Phone Book is a directory of Speed Dial entries (1–89) and Group Dial entries (90-99).

To access a Phone Book entry:
1. From the control panel, press Phone Book.
2. Press ▲ or ▼ repeatedly until the entry you want appears.
   
   or

   Use the keypad to enter the number of the Speed Dial or Group Dial entry.

To access the Phone Book menu:
1. From the control panel, press Fax Mode.
2. Press □.
3. Press ▲ or ▼ repeatedly until Phone Books appears.
4. Press √.
5. Press ▲ or ▼ repeatedly until the setting you want appears.
6. Press √ and follow the instructions on the display.

<table>
<thead>
<tr>
<th>Use this</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Number</td>
<td>Create a new Speed Dial or Group Dial entry.</td>
</tr>
<tr>
<td>Edit Number</td>
<td>Edit a Speed Dial or Group Dial entry.</td>
</tr>
<tr>
<td>Remove Number</td>
<td>Delete a Speed Dial or Group Dial entry.</td>
</tr>
<tr>
<td>Print</td>
<td>Print all Speed Dial and Group Dial entries in the Phone Book.</td>
</tr>
</tbody>
</table>

Note: For instructions on how to add Speed Dial or Group Dial entries to the Phone Book using the computer, see “Setting up Speed Dial numbers” on page 55.

Customizing dial settings

Setting up a dialing prefix
You can add a prefix of up to eight characters to the beginning of each number dialed. Characters can include numbers, commas, and/or the symbols * and #.

1. From the control panel, press Fax Mode.
2. Press □.
3. Press ▲ or ▼ repeatedly until Send Setup appears.
Press \( \checkmark \).

5 Press ▲ or ▼ repeatedly until Dial Prefix appears.

6 Press \( \checkmark \).

7 To change the setting, press ▲ or ▼ repeatedly until Create appears.

8 Press \( \checkmark \).

9 Enter the prefix to be dialed before each telephone number.

10 Press \( \checkmark \) to save the setting.

**Setting the distinctive ring**

Distinctive ring is a service provided by some telephone companies that assigns multiple phone numbers to a single telephone line. If you subscribe to this service, you can program your printer to have a distinctive ring pattern and phone number for incoming faxes.

1 From the control panel, press Fax Mode.

2 Press \( \mathbb{E} \).

3 Press ▲ or ▼ repeatedly until Recv. Setup appears.

4 Press \( \checkmark \).

5 Press ▲ or ▼ repeatedly until Distinct Ring appears.

6 Press \( \checkmark \).

7 Press ▲ or ▼ repeatedly until the ring pattern you want appears.

8 Press \( \checkmark \) to save the setting.

**Setting the number of rings before receiving a fax automatically**

1 From the control panel, press Fax Mode.

2 Press \( \mathbb{E} \).

3 Press ▲ or ▼ repeatedly until Recv. Setup appears.

4 Press \( \checkmark \).

5 Press ▲ or ▼ repeatedly until Number–Rings appears.

6 Press \( \checkmark \).

7 Press ▲ or ▼ repeatedly until the setting you want appears.

8 Press \( \checkmark \) to save the setting.

9 Make sure the Fax Auto Answer light is on.

When the number of rings you set is detected, the printer automatically receives the incoming fax.
**Setting up to fax while behind a PBX**

If the printer is being used in a business or office, it may be connected to a Private Branch Exchange (PBX) telephone system. Ordinarily, when dialing a fax number, the printer waits to recognize the dial tone and then dials the fax number. However, this method of dialing may not work if the PBX telephone system uses a dial tone that is not recognizable to most fax machines. The "Dialing while behind a PBX" feature enables the printer to dial the fax number without waiting to recognize the dial tone.

1. From the control panel, press **Fax Mode**.
2. Press \( \text{Fax} \).
3. Press ▲ or ▼ repeatedly until Send Setup appears.
4. Press ✓.
5. Press ▲ or ▼ repeatedly until Dial Method appears.
6. Press ✓.
7. Press ▲ or ▼ repeatedly until Behind PBX appears.
8. Press ✓ to save this setting.

**Customizing fax settings**

**Customizing settings using the Fax Setup Utility**

You can adjust the fax settings in the Fax Setup Utility. These settings apply to the faxes you send or receive.

1. From the desktop, double-click the **Productivity Suite** icon.
2. Click **Fax**.
3 Click Manage fax history or All-In-One fax settings.

4 Click each tab, and change the settings as needed.

<table>
<thead>
<tr>
<th>On this tab</th>
<th>You can</th>
</tr>
</thead>
</table>
| Send        | • Enter your name and fax number.  
            | **Notes:**  
            |   • You can include a calling card number as part of the fax number.  
            |   • Enter a maximum of 64 digits in a fax number.  
            |   • Select a maximum send speed and print quality for outgoing faxes.  
            |   • Choose whether to scan the entire document before dialing the number.  
            |   • Choose whether to use error correction.  
            |   • Select when to print a fax usage report.  
            |   • Select when to print a fax activity report.  |
### Setting up a fax header

During the initial setup of your printer, you were prompted to enter your name, fax number, date, and time. This information is used to create a fax header for faxes you send.

If you have not entered this information:

1. From the control panel, press **Fax Mode**.
2. Press 3.
3. Press ▲ or ▼ repeatedly until **Send Setup** appears.
4. Press ✓.
5. Press ▲ or ▼ repeatedly until **Personalize** appears.
6. Press ✓.
7. Enter your name using the keypad.
   
   **Note:** You can enter a maximum of 24 characters.
8. Press ✓ to save the setting.
9. Enter your fax number using the keypad.
   
   **Note:** You can enter a maximum of 20 numbers.
10. Press ✓ to save the setting.
11. Press ．
12. Press ▲ or ▼ repeatedly until **Device Setup** appears.

---

<table>
<thead>
<tr>
<th>On this tab</th>
<th>You can</th>
</tr>
</thead>
</table>
| Receive     | • Choose whether to print a footer (the date, time, and page number) to appear on each page you receive.  
             | • Automatically reduce an incoming fax to fit to the paper size loaded, or print it on two sheets of paper.  
             | • Select whether you want to forward a fax, or print it and then forward it.  
             | • Select incoming call options.  
             | • Manage blocked faxes. |
| Dialing     | • Select the number of times you want the machine to redial and the time between those attempts if the fax cannot be sent on the first try.  
             | • Select the telephone line format you want to use.  
             | • Enter a dialing prefix. |
| Speed Dial  | Create, add to, edit, or delete entries from the Speed Dial list, including Group Dial entries. |
13 Press √.
14 Press ▲ or ▼ repeatedly until Date appears.
15 Press √.
16 Enter the date using the keypad.
17 Press √.
18 Press ▲ or ▼ repeatedly until Time appears.
19 Press √.
20 Press ▲ or ▼ to select 12 hr or 24 hr.
21 Press √ to save the setting.
22 Enter the time.
23 Press √.
24 If you selected the 12-hour mode, press ▲ or ▼ to select AM or PM.
25 Press √ to save the setting.

Setting up a fax footer
Using the Fax Setup Utility, you can set up a fax footer that will print on each page of an incoming fax. The footer includes the date and time the fax is received, the page number of the fax, and the telephone number from which the fax was sent.

1 From the desktop, double-click the Productivity Suite icon.
2 Click Fax.
3 Click Manage fax history or All-In-One fax settings.
4 Click the Receive tab.
5 From the “Print footer on each page” area, select On.
6 Click OK.
7 Close the Fax Setup Utility.

Blocking unwanted changes to fax settings
This feature blocks network users from changing fax settings.

1 From the control panel, press Fax Mode.
2 Press □.
3 Press ▲ or ▼ repeatedly until Device Setup appears.
4 Press √.
5 Press ▲ or ▼ until Host Fax Settings appears.
6 Press ✓.

7 Press ▲ or ▼ until Block appears.

8 Press ✓ to save this setting.

**Blocking junk faxes**

If you have Caller ID, you can block faxes sent from specific numbers and/or all faxes which do not include a Caller ID number.

1 From the control panel, press Fax Mode.

2 Press ▼.

3 If you want to block faxes from specific phone numbers:
   a Press ▲ or ▼ repeatedly until Block Faxes appears.
   b Press ✓.
   ▼ appears next to Turn ON/OFF.
   c Press ✓.
   d Press ▲ or ▼ repeatedly until On appears.
   e Press ✓.
   f Press ▲ or ▼ repeatedly until Add Number appears.
   g Press ✓.
   h Enter a phone number.
   i Press ✓.
   j If you want to enter a corresponding name, enter it using the keypad buttons.
   k Press ✓.
   l If you want to enter additional numbers:
     1 Press 1 on the keypad.
     2 Repeat step h through step k.
     Note: You can enter up to 50 phone numbers.
   m If you do not want to enter additional numbers, press 0.

4 If you want to block all faxes that do not provide a Caller ID number:
   a Press ▲ or ▼ repeatedly until No “ID” Calls appears.
   b Press ✓.
   c Press ▲ or ▼ repeatedly until On appears.
   d Press ✓ to save the setting.

5 If you want to print a list of blocked faxes:
   a Press ▲ or ▼ repeatedly until Print List appears.
   b Press ✓ to print the list.
Working with photos

Printing borderless photos

*Printing photos stored on the computer using the Productivity Suite*

1. Load photo paper. For best results, use photo or glossy paper with the glossy or coated side facing down.
2. From the desktop, double-click the **Productivity Suite** icon.
3. Click **Manage photos**.
4. Click **Show Folders**.
5. From the directory in the right panel, select the folder where your photos are stored.
6. Close the directory in the right panel.
7. Select the photos that you want to print by clicking each photo.
8. From the Productivity Tools section, click **Print an album page with various photo sizes**.
9. Click **Change the category of layouts listed above**.
10. Select **Only Borderless**.
11. Click **OK**.
12. Select a paper size for the photos.
13. Select a page layout.
14. Drag your photos onto the page.
15. Click **Print Now**.
Using a PictBridge-enabled digital camera to control printing photos

Connect a PictBridge-enabled digital camera to the printer, and use the buttons on the camera to select and print photos.

1. Insert one end of the USB cable into the camera.
   
   **Note:** Use only the USB cable that came with the digital camera.

2. Insert the other end of the cable into the PictBridge port on the front of the printer.

   ![USB cable connected to printer](image)

   **Note:** Make sure the PictBridge-enabled digital camera is set to the correct USB mode. For more information, see the camera documentation.

3. Follow the instructions in the camera documentation to select and print photos.

Customizing photos

Creating and printing a scrapbook or album page

1. Load paper. For best results, use photo or glossy paper with the glossy or coated side facing down.

2. From the desktop, double-click the **Productivity Suite** icon.

3. Click **Manage Photos**.

4. Click **Show Folders**.

5. From the directory in the right panel, select the folder where your photos are stored.

6. Close the directory in the right panel.

7. From the Productivity Tools section, click **Print an album page with various photo sizes**.

8. From the “Paper Size” drop-down menu, select a paper size.

9. From the “Page Layout” drop-down menu, select a page layout.

   For more options:
   
   a. Click **Change the category of layouts listed above**.
   
   b. Select a layout for the photos.
   
   c. Click **OK**.
   
   d. From the “Page Layout” drop-down menu, select a page layout.
10 Drag the photos onto the page.
   Note: Right-click the photo on the page for editing options.

11 Click Print Now.
   Note: To prevent smudging, remove each page as it exits, and let it dry before stacking.

Adding text captions to a photo page

1 Load paper. For best results, use photo or glossy paper with the glossy or coated side facing down.
2 From the desktop, double-click the Productivity Suite icon.
3 Click Manage Photos.
4 Click Show Folders.
5 From the directory in the right panel, select the folder where your photos are stored.
6 Close the directory in the right panel.
7 Browse and select the photos to which you want to add text.
8 From the Productivity Tools section, click Print an album page with various photo sizes.
9 Click Change the category of layouts listed above.
10 Select Only Scrapbook Pages.
11 Click OK.
12 Select a paper size for the photos.
13 Select a page layout containing a black box.
14 Drag the photos onto the page.
15 Click inside the white box.
   A dialog appears.
16 Enter the text you want.
17 Click OK.
18 Click Print Now to print the photo page.
Networking the printer

Installing a network printer allows users at different workstations to print to a common printer. Methods of setting up a network printer include:

• sharing a printer that is locally attached to a network computer
• a direct Ethernet connection through a print server

Installing network printers

Shared printing

Installing software and sharing the printer on the network (on the host computer)

1 Connect the printer to a network computer using a USB cable.
   If the Found New Hardware dialog appears, click Cancel.
2 Insert the printer software CD.
3 Click Install.
4 Click Continue.
5 Select Yes to share your printer.
6 Assign a shared printer name.
7 When prompted, select Test Page to make sure that the computer can print to the printer.
8 Follow the directions on the computer screen until installation is complete.

Installing the shared printer on other network computers (on the client computers)

<table>
<thead>
<tr>
<th>Using the peer-to-peer method</th>
<th>Using the point-and-print method</th>
</tr>
</thead>
<tbody>
<tr>
<td>a Go to a network computer that you want to enable to print to the shared printer.</td>
<td>a Go to a network computer that you want to enable to print to the shared printer.</td>
</tr>
<tr>
<td>b Insert the printer CD.</td>
<td>b Browse the Network Neighborhood until you find the name of the shared printer assigned in step 6 on page 66.</td>
</tr>
<tr>
<td>c Click Install.</td>
<td>c Right-click the printer icon, and select Open or Connect.</td>
</tr>
<tr>
<td>d From the “Connect Your Printer” dialog, select the network option.</td>
<td>d This will copy a subset of the printer software from the host computer. A printer object will be created in the Printers folder of the client.</td>
</tr>
<tr>
<td>e From the “Networking Setup” dialog, select Peer-to-Peer.</td>
<td>e When prompted, select Test Page to make sure the computer can print to the shared printer.</td>
</tr>
<tr>
<td>f Enter the shared names of both the printer and the network computer you assigned in step 6 on page 66.</td>
<td></td>
</tr>
<tr>
<td>g When prompted, select Test Page to make sure the computer can print to the shared printer.</td>
<td></td>
</tr>
<tr>
<td>h Follow the instructions on the computer screen until installation is complete.</td>
<td></td>
</tr>
<tr>
<td>i Repeat this procedure for each network computer you want to access the shared printer.</td>
<td></td>
</tr>
</tbody>
</table>
**Direct IP printing**

1. Connect the printer to an external print server using a USB cable.
2. Connect the print server to the network using an Ethernet cable.
   - **Note:** You may be connecting your printer directly into a wall connection or through a router. For more information, see the print server documentation.
3. Insert the printer software CD.
4. Click **Install**.
5. From the “Connect Your Printer” dialog, select the network option.
6. From the “Networking Setup” dialog, select **Direct Network Attached**.
7. Select the printer/print server combination from the Network Printers list.
   - **Note:** If more than one is listed, match the MAC address of the print server to the one in the list. For more information, see “Finding your MAC address” on page 67.

**Tips for installing a network printer**

**Assigning an IP address**

An IP address is assigned during printer software installation, but only for Direct IP printing. The print object, created at the end of the installation, sends all print jobs across the network to the printer attached to the print server using this address.

Many networks have the ability to automatically assign an IP address. In smaller networks, it is often called Auto-IP. There are two common types of Auto-IP networks. UPnP network environments provide automatic private IP addresses in the 169.254.x.x range. ICS network environments provide automatic private IP addresses in the 192.168.x.x range. Larger networks may use DHCP to assign addresses. These are usually unique to the company.

During the Direct IP printing installation of printer software, the IP address is visible in the printer list only as it is being assigned. The print object that is created in the Printers folder of the operating system will reference the MAC address of the print server in the port name.

If the IP address is not automatically assigned during printer software installation, you can try manually entering an address after selecting your printer/print server from the available list.

**Finding your MAC address**

You may need the media access control (MAC) address of the print server to complete network printer configuration. The MAC address is a series of letters and numbers listed on the bottom of the external print server.

**Configuring a network printer manually**

1. From the “Configure Network Printers” dialog, highlight the printer you want to configure, and then click **Configure**.
2. Select **DHCP** or **Configure IP Address Manually**.
3. Enter the desired IP address, subnet mask, and gateway for the printer.
4. Click **OK**.
**Finding a printer/print server located on remote subnets**

The printer software CD can automatically find the printers that are located on the same network as the computer. If the printer and print server are located on another network (called a subnet), you must manually enter an IP address during printer software installation.

**Network troubleshooting tips**

1. Make sure the printer is set up correctly. For more information, see the printer setup documentation.
2. Make sure all cable connections are secure. For more information, see the printer or print server setup documentation.
3. Make sure the correct lights are showing on the print server. For more information, see the print server documentation.
4. If the printer software CD cannot find the printer/print server, wait a few minutes, and then try running the CD again. Network traffic speeds vary.
5. Make sure the computer you are using to install the printer is connected to the network.
6. See the print server documentation for additional troubleshooting.
Maintaining the printer

Changing print cartridges

Removing a used print cartridge

1. Make sure the printer is on.

2. Lift the scanner unit.
   The print cartridge carrier moves and stops at the loading position, unless the printer is busy.

3. Press down on the lever to raise the cartridge lid.

4. Remove the used print cartridge.
   To recycle the used cartridge, see “Recycling Lexmark products” on page 74.
   If the cartridge you removed is not empty and you want to use it later, see “Preserving the print cartridges” on page 73.

Note: If you are removing both cartridges, repeat step 3 and step 4 for the second cartridge.
Installing print cartridges

1 If you are installing new print cartridges, remove the sticker and tape from the back and bottom of the cartridges.

**Warning:** Do not touch the gold contact area on the back or the metal nozzles on the bottom of the cartridges.

2 Press down on the cartridge levers to raise the cartridge lids.

3 Insert the black cartridge or the photo cartridge in the left carrier. Insert the color cartridge in the right carrier.

4 Close the lids.
5 Close the scanner unit, making sure to keep your hands out from underneath the scanner unit.

The control panel display will prompt you to print an alignment page. For more information, see “Aligning print cartridges” on page 71.

Note: The scanner unit must be closed to start a new scan, print, copy, or fax job.

Achieving better print quality

Improving print quality

If you are not satisfied with the print quality of a document, make sure you:

- Use the appropriate paper for the document. Use Lexmark Premium Photo Paper if you are printing photos or other high quality images.
- Use a paper that is a heavier weight, bright white, or coated.
- Select a higher print quality.

If the document still does not have the print quality you want, follow these steps:

1 Align the print cartridges. For more information, see “Aligning print cartridges” on page 71.
   If print quality has not improved, continue to step 2.

2 Clean the print cartridge nozzles. For more information, see “Cleaning the print cartridge nozzles” on page 72.
   If print quality has not improved, continue to step 3.

3 Remove and reinsert the print cartridges. For more information, see “Removing a used print cartridge” on page 69 and “Installing print cartridges” on page 70.
   If print quality has not improved, continue to step 4.

4 Wipe the print nozzles and contacts. For more information, see “Wiping the print cartridge nozzles and contacts” on page 72.
   If print quality is still not satisfactory, replace the print cartridges. For more information, see “Ordering supplies” on page 74.

Aligning print cartridges

1 Load plain paper.

2 From the control panel, press Copy Mode.
3 Press □.

4 Press ▲ or ▼ repeatedly until ▶ appears next to Maintenance.

5 Press √.

6 Press ▲ or ▼ repeatedly until ▶ appears next to Align Cartridges.

7 Press √.

An alignment page prints.

If you aligned the cartridges to improve print quality, print your document again. If print quality has not improved, clean the print cartridge nozzles.

**Cleaning the print cartridge nozzles**

1 Load plain paper.

2 Press Copy Mode.

3 Press □.

4 Press ▲ or ▼ repeatedly until ▶ appears next to Maintenance.

5 Press √.

6 Press ▲ or ▼ repeatedly until ▶ appears next to Clean Cartridges.

7 Press √.

A page prints, forcing ink through the print cartridge nozzles to clean them.

8 Print the document again to verify that the print quality has improved.

9 If print quality has not improved, try cleaning the nozzles up to two more times.

**Wiping the print cartridge nozzles and contacts**

1 Remove the print cartridges.

2 Dampen a clean, lint-free cloth with water.

3 Gently hold the cloth against the nozzles for about three seconds, and then wipe in the direction shown.
4 Using another clean section of the cloth, gently hold the cloth against the contacts for about three seconds, and then wipe in the direction shown.

5 With another clean section of the cloth, repeat step 3 and step 4.

6 Let the nozzles and contacts dry completely.

7 Reinsert the print cartridges.

8 Print the document again.

9 If the print quality does not improve, clean the print nozzles. For more information, see “Cleaning the print cartridge nozzles” on page 72.

10 Repeat step 9 up to two more times.

11 If print quality is still not satisfactory, replace the print cartridges.

Preserving the print cartridges

- Keep a new cartridge in its packaging until you are ready to install it.
- Do not remove a cartridge from the printer except to replace, clean, or store it in an airtight container. The cartridges do not print correctly if left exposed for an extended period of time.
- Keep the photo cartridge in its own storage unit when not in use.

Cleaning the scanner glass

1 Dampen a clean, lint-free cloth with water.

2 Gently wipe the scanner glass clean.

Note: Make sure all ink or corrective fluid on a document is dry before placing the document on the scanner glass.
Ordering supplies

To order supplies or to locate a dealer near you, visit our Web site at www.lexmark.com.

<table>
<thead>
<tr>
<th>Item</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black cartridge</td>
<td>32 or 34</td>
</tr>
<tr>
<td>Color cartridge</td>
<td>33 or 35</td>
</tr>
<tr>
<td>Photo cartridge</td>
<td>31</td>
</tr>
<tr>
<td>USB cable</td>
<td>12A2405</td>
</tr>
</tbody>
</table>

Note: For best results, use only Lexmark print cartridges.

Lexmark photo paper types and sizes

- Photo paper (glossy) 4 x 6
- Photo paper (glossy) 8 1/2 x 11
- Photo paper (glossy) A4
- Premium photo paper (high gloss) 4 x 6
- Premium photo paper (high gloss) 8 1/2 x 11
- Premium photo paper (high gloss) A4
- Premium photo paper (high gloss) L

Note: For best results, use Lexmark Premium Photo Paper when printing photos or other high-quality images.

Recycling Lexmark products

To return Lexmark products to Lexmark for recycling:

2. Follow the instructions on the computer screen.
Troubleshooting

- “Setup troubleshooting” on page 75
- “Print troubleshooting” on page 79
- “Copy troubleshooting” on page 82
- “Scan troubleshooting” on page 84
- “Fax troubleshooting” on page 86
- “Network troubleshooting” on page 91
- “Jams and misfeeds troubleshooting” on page 92
- “Error messages” on page 94
- “Removing and reinstalling the software” on page 100

Setup troubleshooting

Incorrect language appears on the display

1. From the control panel, press **Copy Mode**.
2. Press \( \Rightarrow \).
3. Press \( \Uparrow \) or \( \Downarrow \) repeatedly until \( \Rightarrow \) appears next to 9.
4. Press \( \checkmark \).
   \( \Rightarrow \) appears next to 1.
5. Press \( \checkmark \).
6. Press \( \Uparrow \) or \( \Downarrow \) repeatedly until the language you want appears on the display.
7. Press \( \checkmark \) to save the setting.
Power button is not lit

1 Disconnect the power supply cord from the wall outlet, and then from the printer.
2 Plug the cord all the way into the power supply port on the printer.
3 Plug the cord into an electrical outlet that other electrical devices have been using.
4 If the Power button light is not on, press **Power**.

Software does not install

Check the display for an error message. If one appears, see “Error messages” on page 94 for more information.

The following operating systems are supported:

- Windows 98/Me
- Windows 2000
- Windows XP

Check that your computer meets the minimum system requirements listed on the box.

If the printer is connected to the telephone line through another device:

1 Disconnect any answering machines, computers with modems, or telephone line splitters.
2 Directly connect the printer to the telephone line.

1 Check the USB cable for any obvious damage.
2 Firmly plug the rectangular end of the USB cable into the USB port of the computer.
   The USB port is marked with the USB symbol.
3 Firmly plug the square end of the USB cable into the back of the printer.

If the printer is connected to the computer through another device:

1 Disconnect the USB cable from any other device, such as a USB hub or switch box.
2 Directly connect the cable to the printer and the computer.
1. Turn off and then restart your computer.
2. Click **Cancel** on all New Hardware Found screens.
3. Insert the CD, and then follow the instructions on the computer screen to reinstall the software.

1. Press **Power** to turn the printer off.
2. Disconnect the power supply cord from the wall outlet.
3. Gently remove the power supply from the printer.
4. Reconnect the power supply to the printer.
5. Plug the power supply cord into the wall outlet.
6. Press **Power** to turn the printer on.
7. If an error message appears, see “Error messages” on page 94.

1. Close all open software applications.
2. Disable any anti-virus programs.
3. Double-click the **My Computer** icon.
   In Windows XP, click **Start** to access the My Computer icon.
4. Double-click the **CD–ROM drive** icon.
5. If necessary, double-click **setup.exe**.
6. Follow the instructions on the computer screen to install the software.

1. Visit our Web site at [www.lexmark.com](http://www.lexmark.com) to check for the latest software.
2. Click **drivers & downloads**.
3. Click **Find Drivers and Downloads**.
4. Select your printer family.
5. Select your printer model.
6. Select your operating system.
7. Select the file you want to download, and follow the directions on the computer screen.

**Page does not print**

If an error message is displayed, see “Error messages” on page 94.

If the Power button light is not on, see “Power button is not lit” on page 76.

Make sure the black print cartridge is installed. The fax feature works only if it is installed.

Remove and then load paper.

Check the ink levels, and install a new print cartridge if necessary.
1 Remove the print cartridges.
2 Make sure the sticker and tape have been removed.

3 Reinsert the print cartridges.

If the printer is connected to the computer through another device:
1 Disconnect the USB cable from any other device, such as a USB hub or switch box.
2 Directly connect the cable to the printer and the computer.

Make sure the printer is set as the default printer and is not on hold or paused.

1 Click:
   • In Windows XP Pro: Start → Settings → Printers and Faxes.
   • In Windows XP Home: Start → Control Panel → Printers and Faxes.
   • In Windows 2000: Start → Settings → Printers.
   • In Windows 98/Me: Start → Settings → Printers.
2 Double-click the name of your printer.
3 Click Printer.
   • Make sure no check mark appears next to Pause Printing.
   • Make sure a check mark does appear next to Set As Default.

1 Press Power to turn the printer off.
2 Disconnect the power supply cord from the wall outlet.
3 Gently remove the power supply from the printer.
4 Reconnect the power supply to the printer.
5 Plug the power supply cord into the wall outlet.
6 Press Power to turn the printer on.
7 If an error message appears, see “Error messages” on page 94.
Uninstall the printer software, and then reinstall it. For more information, see “Removing and reinstalling the software” on page 100.

If the software still does not install correctly, visit our Web site at www.lexmark.com to check for the latest software.

a. Click drivers & downloads.

b. Click Find Drivers and Downloads.

c. Select your printer family.

d. Select your printer model.

e. Select your operating system.

f. Select the file you want to download, and follow the directions on the computer screen.

Cannot print from digital camera using PictBridge

Enable PictBridge printing on the camera by selecting the correct USB mode. For more information, see the digital camera documentation.

1. Disconnect the camera.

2. Connect a PictBridge-enabled digital camera to the PictBridge port. See the digital camera documentation to determine whether it is PictBridge-enabled.

Use only the USB cable that came with the camera.

Print troubleshooting

Improving print quality

If you are not satisfied with the print quality of a document, make sure you:

• Use the appropriate paper for the document. Use Lexmark Premium Photo Paper if you are printing photos or other high quality images.

• Use a paper that is a heavier weight, bright white, or coated.

• Select a higher print quality.

If the document still does not have the print quality you want, follow these steps:

1. Align the print cartridges. For more information, see “Aligning print cartridges” on page 71.

   If print quality has not improved, continue to step 2.

2. Clean the print cartridge nozzles. For more information, see “Cleaning the print cartridge nozzles” on page 72.

   If print quality has not improved, continue to step 3.

3. Remove and reinsert the print cartridges. For more information, see “Removing a used print cartridge” on page 69 and “Installing print cartridges” on page 70.

   If print quality has not improved, continue to step 4.

4. Wipe the print nozzles and contacts. For more information, see “Wiping the print cartridge nozzles and contacts” on page 72.

   If print quality is still not satisfactory, replace the print cartridges. For more information, see “Ordering supplies” on page 74.
Poor text and graphic quality

Examples of poor text and graphic quality include:

- Blank pages
- Dark print
- Faded print
- Incorrect colors
- Light and dark bands in print
- Skewed lines
- Smudges
- Streaks
- White lines in print

Check the ink levels, and install a new print cartridge if necessary.

See “Improving print quality” on page 79.

To avoid ink smudging when you are working with the following media, remove each sheet as it exits, and allow it to dry:

- Document with graphics or images
- Photo paper
- Coated or glossy paper
- Transparency
- Labels
- Envelopes
- Iron-on transfer

**Note:** Transparencies may take up to 15 minutes to dry.

Use a different brand of paper. Each paper brand accepts ink differently and prints with color variations. Use Lexmark Premium Photo Paper if you are printing photos or other high quality images.

Use only new, unwrinkled paper.

1  Uninstall the printer software, and then reinstall it. For more information, see “Removing and reinstalling the software” on page 100.

2  If the software still does not install correctly, visit our Web site at [www.lexmark.com](http://www.lexmark.com) to check for the latest software.
   a  Click drivers & downloads.
   b  Click Find Drivers and Downloads.
   c  Select your printer family.
   d  Select your printer model.
   e  Select your operating system.
   f  Select the file you want to download, and follow the directions on the computer screen.
**Poor quality at the edges of the page**

Unless you are using the borderless feature, use these minimum print margin settings:
- Left and right margins:
  - 6.35 mm (0.25 in.) for letter size paper
  - 3.37 mm (0.133 in.) for all paper sizes except letter
- Top margin: 1.7 mm (0.067 in.)
- Bottom margin: 16.51 mm (0.65 in.)

Select the Borderless print feature.

1. From the software application, click **File ➔ Print**.
2. Click **Properties, Preferences, Options**, or **Setup**.
3. Click **Print Layout**.
4. Click **Borderless**.

Check that the paper size being used matches the printer setting.

1. From the software application, click **File ➔ Print**.
2. Click **Properties, Preferences, Options**, or **Setup**.
3. Click **Paper Setup**.
4. Check the paper size.

**Printer does not print or respond**

See “Page does not print” on page 77.

**Print speed is slow**

Close all applications not in use.

Try minimizing the number and size of graphics and images in the document.

Consider purchasing more RAM.

Remove as many unused fonts as possible from your system.

1. From the software application, click **File ➔ Print**.
2. Click **Properties, Preferences, Options**, or **Setup**.
3. Click **Quality/Copies**.
4. From the Quality/Speed area, select a lower print quality.
Uninstall the printer software, and then reinstall it. For more information, see “Removing and reinstalling the software” on page 100.

If the software still does not install correctly, visit our Web site at [www.lexmark.com](http://www.lexmark.com) to check for the latest software.

- Click drivers & downloads.
- Click Find Drivers and Downloads.
- Select your printer family.
- Select your printer model.
- Select your operating system.
- Select the file you want to download, and follow the directions on the computer screen.

### Partial document or photo prints

Make sure the document or photo is loaded correctly on the scanner glass.

Make sure the paper size being used matches the size you selected.

### Copy troubleshooting

#### Copier does not respond

If an error message is displayed, see “Error messages” on page 94.

If the Power button light is not on, see “Power button is not lit” on page 76.

Make sure the printer is set as the default printer and is not on hold or paused.

1 Click:
   - In Windows XP Pro: Start → Settings → Printers and Faxes.
   - In Windows XP Home: Start → Control Panel → Printers and Faxes.
   - In Windows 98/Me: Start → Settings → Printers.

2 Double-click the name of your printer.

3 Click Printer.
   - Make sure no check mark appears next to Pause Printing.
   - Make sure a check mark does appear next to Set As Default.

Uninstall the printer software, and then reinstall it. For more information, see “Removing and reinstalling the software” on page 100.

If the software still does not install correctly, visit our Web site at [www.lexmark.com](http://www.lexmark.com) to check for the latest software.

- Click drivers & downloads.
- Click Find Drivers and Downloads.
- Select your printer family.
- Select your printer model.
Select your operating system.

f  Select the file you want to download, and follow the directions on the computer screen.

**Scanner unit does not close**

1  Lift the scanner unit.

2  Remove any obstruction keeping the scanner unit open.

3  Lower the scanner unit.

**Poor copy quality**

Examples include:
- Blank pages
- Checkerboard pattern
- Distorted graphics or pictures
- Missing characters
- Faded print
- Dark print
- Skewed lines
- Smudges
- Streaks
- Unexpected characters
- White lines in print

If an error message is displayed, see “Error messages” on page 94.

Check the ink levels and install a new print cartridge if necessary.

If the scanner glass is dirty, gently wipe it with a clean, lint-free cloth dampened with water.

See “Improving print quality” on page 71.

To adjust the brightness of a copy:

1  Load the document facedown on the scanner glass.

2  From the control panel, press **Copy Mode**.

3  Press **Lighter/Darker**.

4  Press ▲ or ▼ repeatedly to lighten or darken the copy.

5  Press ✓.

6  Press **Start Color** or **Start Black**.

If you are copying or scanning from a newspaper, magazine, or glossy paper, see “Scanning clear images from magazines or newspapers” on page 48.

If the quality of the original is not satisfactory, try using a clearer version of the document or image.
Place the document facedown on the scanner glass.

**Partial document or photo copies**

Make sure the document or photo is loaded correctly in the ADF or on the scanner glass.

Make sure the paper size being used matches the size you selected.

**Scan troubleshooting**

**Scanner does not respond**

If an error message is displayed, see “Error messages” on page 94.

If the Power button light is not on, see “Power button is not lit” on page 76.

Make sure the printer is set as the default printer and is not on hold or paused.

1. Click:
   - In Windows XP Pro: **Start → Settings → Printers and Faxes**.
   - In Windows XP Home: **Start → Control Panel → Printers and Faxes**.
   - In Windows 2000: **Start → Settings → Printers**.
   - In Windows 98/Me: **Start → Settings → Printers**.
2. Double-click the name of your printer.
3. Click **Printer**.
   - Make sure no check mark appears next to Pause Printing.
   - Make sure a check mark does appear next to Set As Default.

1. Uninstall the printer software, and then reinstall it. For more information, see “Removing and reinstalling the software” on page 100.
2. If the software still does not install correctly, visit our Web site at **www.lexmark.com** to check for the latest software.
   - Click **drivers & downloads**.
   - Click **Find Drivers and Downloads**.
   - Select your printer family.
   - Select your printer model.
   - Select your operating system.
   - Select the file you want to download, and follow the directions on the computer screen.

**Scanning takes too long or freezes the computer**

Close all programs not being used.
To change the scanning resolution to a lower value:

1. Click Start → Programs or All Programs → Lexmark 7300 Series.
2. Select All-In-One Center.
3. From the Scan area, click See More Scan Settings.
4. Click Display Advanced Scan Settings.
5. From the Scan Resolution menu, select a lower number.

**Scan was not successful**

1. Check the USB cable for any obvious damage.
2. Firmly plug the rectangular end of the USB cable into the USB port of the computer.
   
   The USB port is marked with the USB symbol.
3. Firmly plug the square end of the USB cable into the back of the printer.

Turn off and then restart your computer.

If the printer is connected to the computer through another device:

1. Disconnect the USB cable from any other device, such as a USB hub or switch box.
2. Directly connect the cable to the printer and the computer.

1. Uninstall the printer software, and then reinstall it. For more information, see “Removing and reinstalling the software” on page 100.
2. If the software still does not install correctly, visit our Web site at www.lexmark.com to check for the latest software.
   
   a. Click drivers & downloads.
   b. Click Find Drivers and Downloads.
   c. Select your printer family.
   d. Select your printer model.
   e. Select your operating system.
   f. Select the file you want to download, and follow the directions on the computer screen.

**Poor scanned image quality**

If an error message is displayed, see “Error messages” on page 94.

If the scanner glass is dirty, gently wipe it with a clean, lint-free cloth dampened with water.

To adjust the quality of a scan:

1. Load the document facedown on the scanner glass.
2. From the control panel, press Scan Mode.
4 Press ▲ or ▼ repeatedly until the quality you want appears.

5 Press ✓.

6 Press **Start Color** or **Start Black**.

See “Improving print quality” on page 71.

If you are copying or scanning from a newspaper, magazine, or glossy paper, see “Scanning clear images from magazines or newspapers” on page 48.

If the quality of the original is not satisfactory, try using a clearer version of the document or image.

Place the document facedown on the scanner glass.

**Partial document or photo scans**

Make sure the document or photo is loaded correctly in the ADF or on the scanner glass.

Make sure the paper size being used matches the size you selected.

**Cannot scan to an application**

1 From the Selected Application Does Not Support Multiple Pages dialog, click **Cancel**.

2 From the All-In-One Center Scanning and Copying tab, choose a different application from the “Send scanned image to” menu.

3 Scan the document.

**Cannot scan to a computer over a network**

See “Scanning to a computer over a network” on page 49.

**Fax troubleshooting**

**Tips for faxing using the Productivity Suite**

If you are faxing using the Productivity Suite, make sure:

• The printer is connected to a computer that is equipped with a fax modem.
• The computer is connected to a working phone line.
• Both the printer and the computer are turned on.

For additional help when you are using a fax application, see the documentation that came with the fax application.

**Cannot send or receive a fax**

If an error message appears, follow the instructions on the error message dialog.

If the Power light is not on, see “Power button is not lit” on page 76.
Make sure cable connections for the following hardware are secure, if applicable:

- Power supply
- Telephone
- Handset
- Answering machine

Check the telephone wall jack.

1. Plug a telephone into the wall jack.
2. Listen for a dial tone.
3. If you do not hear a dial tone, plug a different telephone into the wall jack.
4. If you still do not hear a dial tone, plug a telephone into a different wall jack.
5. If you hear a dial tone, connect the printer to that wall jack.

Place a test call to the telephone number to which you want to send a fax to make sure that it is working correctly.

The fax modem is an analog device. Certain devices can be connected to the printer so that digital telephone services can be used.

- If you are using an ISDN telephone service, connect the printer to an analog telephone port (an R-interface port) on an ISDN terminal adapter. For more information and to request an R-interface port, contact your ISDN provider.
- If you are using DSL, connect to a DSL filter or router that will support analog use. For more information, contact your DSL provider.
- If you are using a PBX telephone service, make sure you are connecting to an analog connection on the PBX. If none exists, consider installing an analog telephone line for the fax machine. For more information on faxing when using a PBX telephone service, see “Setting up to fax while behind a PBX” on page 58.

If the telephone line is being used by another device, wait until the other device is finished before sending a fax.

If you are using the On Hook Dial feature, turn up the volume to verify a dial tone.

To ensure the printer is working correctly, connect it directly to the telephone line. Disconnect any answering machines, computers with modems, or telephone line splitters.

Check for and clear any paper jams.

Make sure the black print cartridge is installed. The fax feature works only if it is installed.

Call Waiting can disrupt fax transmissions. Disable this feature before sending or receiving a fax. Call your telephone company to obtain the keypad sequence for temporarily disabling Call Waiting.

Voice Mail offered through your local telephone company may disrupt fax transmissions. To enable both Voice Mail and the printer to answer calls:

- See “Setting the distinctive ring” on page 57. Setting selections include single ring, double ring, triple ring, and any ring.
- Consider adding a second telephone line for the printer.

Make sure the country code has been set for the country or region where you are operating the printer:

1. From the control panel, press Fax Mode.
2. Press 87.
3 Press ▲ or ▼ repeatedly until Device Setup appears.

4 Press √.

5 Press ▲ or ▼ repeatedly until Country Code appears.

6 Press √.

7 Press ▲ or ▼ repeatedly until the country where you are operating the printer appears.

8 Press √ to save the setting.

If the printer memory is full:

1 Dial the receiving number.

2 Scan the original document one page at a time.

**Can send but not receive faxes**

Load paper to print any faxes that have been stored in the printer.

Check the status of the Fax Auto Answer feature.

If the Fax Auto Answer light is on:

- The printer will answer after the preset number of telephone rings.
- If you are using a distinctive ring, see “Setting the distinctive ring” on page 57.

Check the ink levels, and install a new cartridge if necessary.

Check to see whether Fax Forwarding is selected.

1 From the control panel, press Fax Mode.

2 Press ❯.

3 Press ▲ or ▼ repeatedly until Recv. Setup appears.

4 Press √.

5 Press ▲ or ▼ repeatedly until Fax Forward appears.

6 Press √.

7 Press ▲ or ▼ repeatedly to view the current Fax Forwarding setting.

8 To turn off Fax Forwarding, press ▲ or ▼ repeatedly until Off appears.

9 Press √ to save the setting.

**Can receive but not send faxes**

To make sure the printer is set for faxing, press Fax Mode.

Load the original document facedown in the upper left corner of the scanner glass or faceup in the ADF.
Check the Dial Prefix setting.

1. From the control panel, press Fax Mode.
2. Press \(\square\).
3. Press \(\uparrow\) or \(\downarrow\) repeatedly until Send Setup appears.
4. Press \(\checkmark\).
5. Press \(\uparrow\) or \(\downarrow\) repeatedly until Dial Prefix appears.
6. Press \(\checkmark\).
7. To change the setting, press \(\uparrow\) or \(\downarrow\) repeatedly until Create appears.
8. Press \(\checkmark\).
9. Enter the prefix to be dialed before each telephone number.
10. Press \(\checkmark\).

If you used a Speed Dial button:
- Check to make sure it has been programmed for the number that you wish to dial. See “Setting up Speed Dial numbers” on page 55.
- As an alternative, dial the telephone number manually.

Make sure the printer is detecting a dial tone.
- See “Sending a fax while listening to a call (On Hook Dial)” on page 52.
- Check the Dial Method setting.
  1. Listen for a dial tone. If you hear a dial tone but the printer hangs up without dialing, this means it did not recognize the dial tone.
  2. From the control panel, press Fax Mode.
  3. Press \(\square\).
  4. Press \(\uparrow\) or \(\downarrow\) repeatedly until Send Setup appears.
  5. Press \(\checkmark\).
  6. Press \(\uparrow\) or \(\downarrow\) repeatedly until Dial Method appears.
  7. Press \(\checkmark\).
  8. Press \(\uparrow\) or \(\downarrow\) repeatedly until the method you want appears.
  9. Press \(\checkmark\) to save this setting.

**Printer receives a blank fax**

Ask the sender to verify the original document was loaded correctly.

Check the ink levels, and install a new print cartridge if necessary.
1 Remove the print cartridges.

2 Make sure the sticker and tape have been removed.

3 Reinsert the print cartridges.

**Received fax has poor print quality**

Ask that the sender:

- Check that the quality of the original document is satisfactory.
- Resend the fax. There may have been a problem with the quality of the telephone line connection.
- Increase the fax scan resolution.

Change the fax quality setting:

1 From the control panel, press **Fax Mode**.

2 Press **Quality**.

3 Press ▲ or ▼ repeatedly to select a higher fax quality.

4 Press ✓ to save the setting.

Check the ink levels and install a new print cartridge if necessary.

Decrease the transmission speed.

1 From the control panel, press **Fax Mode**.

2 Press ▶.

3 Press ▲ or ▼ repeatedly until **Send Setup** appears.

4 Press ✓.

5 Press ▲ or ▼ repeatedly until **Max Speed** appears.

6 Press ✓.

7 Press ▲ or ▼ to select a lower transmission speed.

8 Press ✓ to save the setting.
9 Resend the fax.

10 If the problem persists, repeat step 1 through step 9 to resend the fax at successively lower transmission speeds.
   \textbf{Note:} 2400 bps is the lowest transmission speed.

\textbf{Notes:}
\begin{itemize}
  \item The lower the transmission speed, the longer it will take your fax to print.
  \item This solution will reduce the speed for future faxes until you reset the transmission speed.
\end{itemize}

\section*{Network troubleshooting}

\textit{The printer to be configured does not appear in the list of printers found on your network}

SSID is not being broadcast. Make sure security keys are correct.

Make sure the printer is connected to a power source and is turned on. For more information, see “Power button is not lit” on page 76.

If you are using a print server:
\begin{itemize}
  \item[1] Check the Ethernet cable for any obvious damage.
  \item[2] Firmly plug one end of the Ethernet cable into the printer or the print server.
  \item[3] Firmly plug the other end of the Ethernet cable into the network hub or wall connection.
\end{itemize}

If you are also using a USB cable:
\begin{itemize}
  \item[1] Check the USB cable for any obvious damage.
  \item[2] Firmly plug the rectangular end of the USB cable into the USB port of the computer.
    \textit{The USB port is marked with the USB symbol \textcircled{U}.}
  \item[3] Firmly plug the square end of the USB cable into the USB port on the back of the printer.
\end{itemize}

See the print server documentation for setup instructions if:
\begin{itemize}
  \item The lights of the print server are not on.
  \item The USB cable is not connected to the print server.
  \item The print server is not connected to a power source.
\end{itemize}

If none of the previous actions fixes the problem, uninstall the printer software, and reinstall it. For more information, see “Removing and reinstalling the software” on page 100.

\section*{Cannot print to the network printer}

See the print server documentation for setup instructions if:
\begin{itemize}
  \item The lights of the print server are not on.
  \item The USB cable is not connected to the print server.
  \item The print server is not connected to a power source.
Check the Ethernet cable for any obvious damage.

Firmly plug one end of the Ethernet cable into the printer.

Firmly plug the other end of the Ethernet cable into the network hub or wall connection.

If you are also using a USB cable:

Check the USB cable for any obvious damage.

Firmly plug the rectangular end of the USB cable into the USB port of the computer.

The USB port is marked with the USB symbol.

Firmly plug the square end of the USB cable into the USB port on the back of the printer.

Contact your system support person to make sure the printer is connected to a working network connection.

Make sure the printer is connected to a power source and is turned on. For more information, see “Power button is not lit” on page 76.

**Network name does not appear in the list**

SSID is not being broadcast. Make sure security keys are correct.

**Jams and misfeeds troubleshooting**

**Paper jam in the printer**

To remove the paper:

1. Open the rear access door.
2. Firmly grasp the paper, and gently pull it out.
3. Close the rear door.
4. Press ✓.

If the paper is accessible from the front of the printer:

1. Raise the paper exit tray.
2. Firmly grasp the paper, and gently pull it out.
3. Lower the paper exit tray.
4. Press ✓.

**Paper jam in the ADF**

1. Flip open the ADF by grasping the notch in the left side of the ADF and pulling up.
2. Firmly grasp the paper, and gently pull it out.
3 Close the ADF.
4 Press √.

**Paper or specialty media misfeeds**

If paper or specialty media misfeeds or skews, or multiple sheets feed or stick together, try the following solutions.

Load a smaller amount of paper into the printer.

See “Loading various paper types” on page 35 for information about:
- Maximum loading amounts per paper type
- Specific loading instructions for supported paper and specialty media

Load paper with the print side facing down.

Remove each page as it exits, and let it dry completely before stacking.

Use only new, unwrinkled paper.

Adjust the paper guides:
- When using media less than 8.5 inches wide
- Against the edges of the paper or media, making sure it does not buckle

---

**Printer does not feed paper, envelopes, or specialty media**

If there is a paper jam, see the appropriate paper jam section.

Verify that the specialty media is loaded correctly.

Try loading one page, envelope, or sheet of specialty media at a time.

Make sure the printer is set as the default printer and is not on hold or paused.

1 Click:
   - In Windows XP Pro: **Start** → **Settings** → **Printers and Faxes**.
   - In Windows XP Home: **Start** → **Control Panel** → **Printers and Faxes**.
   - In Windows 2000: **Start** → **Settings** → **Printers**.
   - In Windows 98/Me: **Start** → **Settings** → **Printers**.

2 Double-click the name of your printer.

3 Click **Printer**.
   - Make sure no check mark appears next to Pause Printing.
   - Make sure a check mark does appear next to Set As Default.
Banner paper jams

1. Press **Power** to turn off the printer.
2. Remove the jammed banner paper from the printer.

To keep a banner print job from jamming:
- Use only the number of sheets needed for the banner.
- Select the following settings to enable the printer to feed paper continuously without jamming:
  1. With a document open, click **File** ➔ **Print**.
  2. Click **Properties**, **Preferences**, **Options**, or **Setup**.
  3. Select the **Paper Size** tab.
  4. From the Paper Size area, select **Banner**.
  5. Select **Letter Banner** or **A4 Banner** as the paper size.
  6. From the Print Layout tab, select **Banner**.

Error messages

**Black Ink Low/Color Ink Low/Photo Ink Low**

1. Check the indicated ink level or levels and install a new cartridge or cartridges, if necessary. Low ink warnings occur when a cartridge is 25% full, 15% full, and 10% full.
   
   To order supplies, see “Ordering supplies” on page 74.

2. Press ✓ to continue.

**Clear Paper Jam**

See “Paper jam in the printer” on page 92.

**Clear ADF Jam**

See “Paper jam in the ADF” on page 92.

**Left Cartridge Error/Right Cartridge Error**

This includes the following cartridge errors:
- Left Cartridge Incorrect/Right Cartridge Incorrect
- 1205 (Left Cartridge)
- 1206 (Right Cartridge)

1. Remove the indicated print cartridge.
2. Disconnect the power supply cord from the electrical outlet.
3. Reconnect the power supply cord to the electrical outlet.
4. If the Power button is not lit, press **Power**.
5 Reinsert the print cartridge.

6 If the error:
   • Does not reappear, the problem has been corrected.
   • Reappears, replace the print cartridge with a new one.

**Cartridge Error**
This includes the following cartridge errors:
- 1203
- 1204
- 120F

**Procedure 1**

1 Remove the print cartridges.

2 Disconnect the power supply cord from the electrical outlet.

3 Reconnect the power supply cord to the electrical outlet.

4 If the Power button is not lit, press Power.

5 Reinsert the print cartridges.

6 If the error:
   • Does not reappear, the problem has been corrected.
   • Reappears, one of the cartridges is not working properly. Continue with Procedure 2.

**Procedure 2**
Follow this procedure to determine which cartridge is not working properly.

1 Remove the print cartridges.

2 Disconnect the power supply cord from the electrical outlet.

3 Reconnect the power supply cord to the electrical outlet.

4 If the Power button is not lit, press Power.

5 Reinsert the black (or photo) print cartridge.

6 If the error:
   • Reappears, replace the black (or photo) print cartridge with a new one.
   • Does not reappear, reinsert the color print cartridge.

7 If the error reappears, replace the color print cartridge with a new one.

**Clear Carrier Jam**

1 Raise the scanner unit.

2 Remove any objects blocking the path of the cartridge carrier.
3 Make sure the cartridge lids are closed.

4 Close the scanner unit.

5 Press \(\checkmark\).

1 Press **Power** to turn the printer off.
2 Disconnect the power supply cord from the wall outlet.
3 Raise the scanner unit.
4 Remove both print cartridges. For more information, see “Removing a used print cartridge” on page 69.
5 Make sure the cartridge lids are closed.

6 Close the scanner unit.
7 Plug the power supply cord into the wall outlet.
8 Press **Power** to turn the printer on.
9 Reinstall the print cartridges. For more information, see “Installing print cartridges” on page 70.

**Left Cartridge Missing/Right Cartridge Missing**

One or both cartridges are missing or not installed properly. For more information, see “Installing print cartridges” on page 70.

**Notes:**

- You can make a color copy with only the color cartridge installed.
- You can print a black and white document with only the black cartridge installed.
- You cannot copy or print when only the photo cartridge is installed.
- To remove the error message, press \(\times\).

**Error: 1104**

1 Remove the print cartridges.
2 Reinstall the black cartridge or the photo cartridge in the left carrier.
3 Reinstall the color cartridge in the right carrier.

Alignment Problem

1 Remove the print cartridges.

2 Make sure the sticker and tape have been removed.

3 Reinsert the print cartridges.

4 Press ✓ to align the cartridges.

Load only plain, unmarked paper for aligning cartridges.
The printer will read any markings on used paper, which could cause the alignment error message to appear.

Fax Error

The fax machines have stopped communicating.
Resend the fax. There may have been a problem with the quality of the telephone line connection.

Fax Mode Unsupported

The receiving fax machine does not support the type of fax you attempted to send. If it does not support:
• Your scan resolution—lower the scan resolution.
  1 From the control panel, press **Fax Mode**.
  2 Press **Quality**.
  3 Press ▲ or ▼ repeatedly until a lower quality appears.
  4 Press ✓.
• Legal size paper—reformat the document on letter size paper.

Failed to Connect

Resend the fax. There may have been a problem with the quality of the telephone line connection.
Place a test call to the telephone number to which you want to send a fax to make sure that it is working correctly.
If the telephone line is being used by another device, wait until the other device is finished before sending the fax.

Make sure the printer is detecting a dial tone.

- See “Sending a fax while listening to a call (On Hook Dial)” on page 52.
- Check the Dial Method setting.

1. Listen for a dial tone. If you hear a dial tone but the printer hangs up without dialing, this means it did not recognize the dial tone.
2. From the control panel, press Fax Mode.
3. Press Enter.
4. Press ▲ or ▼ repeatedly until Send Setup appears.
5. Press Enter.
6. Press ▲ or ▼ repeatedly until Dial Method appears.
7. Press Enter.
8. Press ▲ or ▼ repeatedly until the method you want appears.
9. Press Enter to save this setting.

Phone Line Error

If the telephone line is being used by another device, wait until the other device is finished before sending the fax.

Make sure cable connections for the following hardware are secure, if applicable:
- Power supply
- Telephone
- Handset
- Answering machine

The fax modem is an analog device. Certain devices can be connected to the printer so that digital telephone services can be used.

- If you are using an ISDN telephone service, connect the printer to an analog telephone port (an R-interface port) on an ISDN terminal adapter. For more information and to request an R-interface port, contact your ISDN provider.
- If you are using DSL, connect to a DSL filter or router that will support analog use. For more information, contact your DSL provider.
- If you are using a PBX telephone service, make sure you are connecting to an analog connection on the PBX. If none exists, consider installing an analog telephone line for the fax machine. For more information on faxing when using a PBX telephone service, see “Setting up to fax while behind a PBX” on page 58.

Remote Fax Error

Resend the fax. There may have been a problem with the quality of the telephone line connection.

Lower the transmission speed.

1. From the control panel, press Fax Mode.
2. Press Enter.
3 Press ▲ or ▼ repeatedly until **Send Setup** appears.

4 Press ✓.

5 Press ▲ or ▼ repeatedly until **Max Speed** appears.

6 Press ✓.

7 Press ▲ or ▼ repeatedly until a lower speed appears.

8 Press ✓.

**Notes:**

- The lower the transmission speed, the longer it will take your fax to print.
- This solution will reduce the speed for future faxes until you reset the transmission speed.

9 Resend the fax.

10 If the problem persists, repeat step 1 through step 9 to send the fax at successively lower transmission speeds.

**Phone Line Busy**

The printer automatically redials three times at 3-minute intervals. You can change the default settings to redial up to five times at intervals up to 8 minutes.

To change the redial settings:

1 From the control panel, press **Fax Mode**.

2 Press .

3 Press ▲ or ▼ repeatedly until ➡ appears next to **Send Setup**.

4 Press ✓.

5 To change the number of times the printer will redial:
   a Press ▲ or ▼ repeatedly until ➡ appears next to **Redial Tries**.
   b Press ✓.
   c Press ▲ or ▼ repeatedly until ➡ appears next to the setting you want.
   d Press ✓.

6 To change the length of time between redials:
   a Press ▲ or ▼ repeatedly until ➡ appears next to **Redial Times**.
   b Press ✓.
   c Press ▲ or ▼ repeatedly until ➡ appears next to the setting you want.
   d Press ✓.

To resend the fax later at a scheduled time:

1 From the control panel, press **Fax Mode**.

2 Press .
3 Press ▲ or ▼ repeatedly until ☐ appears next to Delay Fax.

4 Press ☐.

☐ appears next to Delay Current.

5 Press ☐.

6 Enter the time and date you want to send the fax.
   • Use the arrows to navigate to each box.
   • Press 1 for AM, 2 for PM, or 3 for 24-hour mode.

7 Press ☐ to save your settings and exit the menu.

8 Enter the fax number.

9 Press Start Black to send your fax at the designated time.

Memory Full

If applicable, to reduce memory use:
   • Print pending received faxes.
   • Send fewer pages.

Lower the fax resolution.

1 From the desktop, double-click the Productivity Suite icon.

2 Click Fax.

3 Click Manage fax history or All-In-One fax settings.

4 Click the Send tab.

5 From the “Send fax with this print quality” area, select a lower print quality.

6 Click OK.

Note: The lower fax resolution becomes the default setting for all faxes you send or receive.

7 Resend the fax.

Removing and reinstalling the software

If the printer is not functioning properly, or if a communications error message appears when you try to use the printer, you may need to remove and reinstall the printer software.

1 Close all open software applications.

2 Disable any anti-virus programs.

3 Click Start → Programs or All Programs → Lexmark 7300 Series.

4 Select Uninstall.

5 Follow the instructions on the computer screen to remove the printer software.

6 Restart the computer before reinstalling the printer software.
7 Click **Cancel** on all New Hardware Found screens.

8 Insert the CD, and then follow the instructions on the computer screen to reinstall the software.
Notices

<table>
<thead>
<tr>
<th>Product name</th>
<th>Lexmark™ 7300 Series All-In-One</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model number</td>
<td>7300</td>
</tr>
<tr>
<td>Machine type</td>
<td>4418–060, 4418–A60, 4418–G60</td>
</tr>
</tbody>
</table>

**Trademarks**

Lexmark and Lexmark with diamond design are trademarks of Lexmark International, Inc., registered in the United States and/or other countries.

All other trademarks are the property of their respective owners.

**Conventions**

*Note:* A note identifies something that could help you.

*CAUTION:* A caution identifies something that could cause you harm.

*Warning:* A warning identifies something that could damage your product hardware or software.

**Federal Communications Commission (FCC) compliance information statement**

This product has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

The FCC Class B limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult your point of purchase or service representative for additional suggestions.

The manufacturer is not responsible for radio or television interference caused by using other than recommended cables or by unauthorized changes or modifications to this equipment. Unauthorized changes or modifications could void the user's authority to operate this equipment.

*Note:* To assure compliance with FCC regulations on electromagnetic interference for a Class B computing device, use a properly shielded and grounded cable such as Lexmark part number 12A2405 for USB attach. Use of a substitute cable not properly shielded and grounded may result in a violation of FCC regulations.
Any questions regarding this compliance information statement should be directed to:

Director of Lexmark Technology & Services
Lexmark International, Inc.
740 West New Circle Road
Lexington, KY 40550
(859) 232–3000

Industry Canada compliance statement
This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

Avis de conformité aux normes de l’industrie du Canada
Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.

European Community (EC) directives conformity
This product is in conformity with the protection requirements of EC Council directives 89/336/EEC, 73/23/EEC, and 1999/5/EC on the approximation and harmonization of the laws of the Member States relating to electromagnetic compatibility and safety of electrical equipment designed for use within certain voltage limits and on radio equipment and telecommunications terminal equipment.

A declaration of conformity with the requirements of the directives has been signed by the Director of Manufacturing and Technical Support, Lexmark International, Inc., S.A., Boigny, France.

This product satisfies the Class B limits of EN 55022 and safety requirements of EN 60950.

Noise emission levels
The following measurements were made in accordance with ISO 7779 and reported in conformance with ISO 9296.

<table>
<thead>
<tr>
<th>1-meter average sound pressure, dBA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printing</td>
</tr>
<tr>
<td>Scanning</td>
</tr>
<tr>
<td>Copying</td>
</tr>
</tbody>
</table>

Waste from Electrical and Electronic Equipment (WEEE) directive

The WEEE logo signifies specific recycling programs and procedures for electronic products in countries of the European Union. We encourage the recycling of our products. If you have further questions about recycling options, visit the Lexmark Web site at www.lexmark.com for your local sales office phone number.
Federal Communications Commission (FCC) compliance information statement

This equipment complies with Part 68 of the FCC rules and the requirements adopted by the Administrative Council for Terminal Attachments (ACTA). On the back of this equipment is a label that contains, among other information, a product identifier in the format US:AAAEQ##TXXXX. If requested, this number must be provided to your telephone company.

This equipment uses the RJ-11C Universal Service Order Code (USOC) jack.

A plug and jack used to connect this equipment to the premises' wiring and telephone network must comply with the applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant telephone cord and modular plug is provided with this product. It is designed to be connected to a compatible modular jack that is also compliant. See your setup documentation for more information.

The Ringer Equivalence Number (REN) is used to determine the number of devices that may be connected to a telephone line. Excessive RENs on a telephone line may result in the devices not ringing in response to an incoming call. In most but not all areas, the sum of RENs should not exceed five (5.0). To be certain of the number of devices that may be connected to a line, as determined by the total RENs, contact your local telephone company. For products approved after July 23, 2001, the REN for this product is part of the product identifier that has the format US:AAAEQ##TXXXX. The digits represented by ## are the REN without a decimal point (for example, 03 is a REN of 0.3). For earlier products, the REN is shown separately on the label.

If this equipment causes harm to the telephone network, the telephone company will notify you in advance that temporary discontinuance of service may be required. If advance notice is not practical, the telephone company will notify the customer as soon as possible. You will also be advised of your right to file a complaint with the FCC.

The telephone company may make changes in its facilities, equipment, operations or procedures that could affect the operation of this equipment. If this happens, the telephone company will provide advance notice in order for you to make necessary modifications to maintain uninterrupted service.

If you experience trouble with this equipment, for repair or warranty information, contact Lexmark International, Inc. at www.lexmark.com or your Lexmark representative. If the equipment is causing harm to the telephone network, the telephone company may request that you disconnect the equipment until the problem is resolved.

This equipment contains no user serviceable parts. For repair and warranty information, contact Lexmark International, Inc. See the previous paragraph for contact information.

Connection to party line service is subject to state tariffs. Contact the state public utility commission, public service commission, or corporation commission for information.

If your home has specially wired alarm equipment connected to the telephone line, ensure the installation of this equipment does not disable your alarm equipment. If you have questions about what will disable alarm equipment, consult your telephone company or a qualified installer.

Telephone companies report that electrical surges, typically lightning transients, are very destructive to customer terminal equipment connected to AC power sources. This has been identified as a major nationwide problem. It is recommended that the customer install an appropriate AC surge arrester in the AC outlet to which this device is connected. An appropriate AC surge arrester is defined as one that is suitably rated, and certified by UL (Underwriter's Laboratories), another NRTL (Nationally Recognized Testing Laboratory), or a recognized safety certification body in the country/region of use. This is to avoid damage to the equipment caused by local lightning strikes and other electrical surges.

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or other electronic device, including fax machines, to send any message unless said message clearly contains in a margin at the top or bottom of each transmitted page or on the first page of the transmission, the date and time it is sent and an identification of the business or other entity, or other individual sending the message, and the telephone number of the sending machine or such business, other entity, or individual. (The telephone number provided may not be a 900 number or any other number for which charges exceed local or long-distance transmission charges.)
See your user documentation in order to program this information into your fax machine.

**Other telecommunications notices**

**Notice to users of the Canadian telephone network**

This product meets the applicable Industry Canada technical specifications. The Ringer Equivalence Number (REN) is an indication of the maximum number of terminals allowed to be connected to a telephone interface. The terminus of an interface may consist of any combination of devices, subject only to the requirement that the sum of the RENs of all the devices does not exceed five. The modem REN is located on the rear of the equipment on the product labeling.

Telephone companies report that electrical surges, typically lightning transients, are very destructive to customer terminal equipment connected to AC power sources. This has been identified as a major nationwide problem. It is recommended that the customer install an appropriate AC surge arrester in the AC outlet to which this device is connected. An appropriate AC surge arrester is defined as one that is suitably rated, and certified by UL (Underwriter’s Laboratories), another NRTL (Nationally Recognized Testing Laboratory), or a recognized safety certification body in the country/region of use. This is to avoid damage to the equipment caused by local lightning strikes and other electrical surges.

This equipment uses CA11A telephone jacks.

**Notice to users of the New Zealand telephone network**

The following are special conditions for the Facsimile User Instructions. The grant of a telepermit for any item of terminal equipment indicates only that Telecom has accepted that the item complies with minimum conditions for connection to its network. It indicates no endorsement of the product by Telecom, nor does it provide any sort of warranty. Above all, it provides no assurance that any item will work correctly in all respects with another item of telepermitted equipment of a different make or model, nor does it imply that any product is compatible with all of Telecom's network services.

This equipment shall not be set up to make automatic calls to the Telecom’s 111 Emergency Service.

This equipment may not provide for the effective hand-over of a call to another device connected to the same line.

This equipment should not be used under any circumstances that may constitute a nuisance to other Telecom customers.

Some parameters required for compliance with Telecom's telepermit requirements are dependent on the equipment associated with this device. The associated equipment shall be set to operate within the following limits for compliance to Telecom's specifications:

- There shall be no more than 10 call attempts to the same number within any 30 minute period for any single manual call initiation, and
- The equipment shall go on-hook for a period of not less than 30 seconds between the end of one attempt and the beginning of the next call attempt.
- The equipment shall be set to ensure that automatic calls to different numbers are spaced such that there is not less than 5 seconds between the end of one call attempt and the beginning of another.

**South Africa telecommunications notice**

This modem must be used in conjunction with an approved surge protection device when connected to the PSTN.

**Using this product in Germany**

This product requires a German billing tone filter (Lexmark part number 14B5123) to be installed on any line which receives metering pulses in Germany. Metering pulses may or may not be present on analog lines in Germany. The subscriber may request that metering pulses be placed on the line, or have them removed by calling the German network provider. Normally, metering pulses are not provided unless specifically requested by the subscriber at the time of installation.
Using this product in Switzerland

This product requires a Swiss billing tone filter (Lexmark part number 14B5109) to be installed on any line which receives metering pulses in Switzerland. The Lexmark filter must be used, as metering pulses are present on all analog telephone lines in Switzerland.

ENERGY STAR

Power consumption

Product power consumption

It is sometimes helpful to calculate the total product energy usage. Since power consumption claims are provided in power units of Watts, the power consumption should be multiplied by the time the product spends in each mode in order to calculate energy usage. The total product energy usage is the sum of each mode's energy usage.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
<th>Power consumption</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printing</td>
<td>The product is generating hard-copy output.</td>
<td>14.0 W</td>
</tr>
<tr>
<td>Copying</td>
<td>The product is generating hard-copy output from hard-copy original documents.</td>
<td>13.0 W</td>
</tr>
<tr>
<td>Scanning</td>
<td>The product is scanning hard-copy documents.</td>
<td>13.0 W</td>
</tr>
<tr>
<td>Ready</td>
<td>The product is waiting for a print job.</td>
<td>7.0 W</td>
</tr>
<tr>
<td>Power Saver</td>
<td>The product is in energy-saving mode.</td>
<td>7.0 W</td>
</tr>
<tr>
<td>Off</td>
<td>The product is plugged into a wall outlet, but the switch is turned off.</td>
<td>4.5 W</td>
</tr>
</tbody>
</table>

The power consumption levels listed in the previous table represent time-averaged measurements. Instantaneous power draws may be substantially higher than the average.

Power Saver

This product is designed with an energy-saving mode called Power Saver. The Power Saver Mode is equivalent to the EPA Sleep Mode. The Power Saver Mode saves energy by lowering power consumption during extended periods of inactivity. The Power Saver Mode is automatically engaged after this product is not used for a specified period of time, called the Power Saver Timeout.

Factory default Power Saver Timeout for this product (in minutes): 30

Off mode

This product has an off mode which still consumes a small amount of power. To completely stop product power consumption, disconnect the power supply from the wall outlet.
**Total energy usage**

It is sometimes helpful to calculate the total product energy usage. Since power consumption claims are provided in power units of Watts, the power consumption should be multiplied by the time the product spends in each mode in order to calculate energy usage. The total product energy usage is the sum of each mode's energy usage.

**Mercury statement**

This product contains mercury in the lamp (<5mg Hg). Disposal of mercury may be regulated due to environmental considerations. For disposal or recycling information, contact your local authorities or the Electronic Industries Alliance: [www.eliae.org](http://www.eliae.org).
Index

A
adding text captions 65
ADF
exit tray 18
input tray 18
loading documents 38
paper capacity 39
scanning multiple pages 47
album page, creating 64
aligning print cartridges 71
alignment problem 97
All-In-One Center
Maintain/Troubleshoot link 29
opening 27
Saved Images tab 29
Scanning & Copying tab 28
answering machine, receiving a fax with 53
assigning IP address 67
Attach to E-mail button 27
Automatic Document Feeder (ADF) 18

B
banner paper jams 94
banner paper, loading 38
black ink low error 94
blocking host fax settings 61
borderless photos, printing 63
box contents 11
brightness, Fax menu 24
broadcast fax, sending at a scheduled time 52
immediately 51
buttons, control panel
Back 21
Cancel 21
Copy Mode 20
Down arrow 21
Fax Auto Answer 20
Fax Mode 20
keypad 22
Menu 21
Quick Dial buttons 20
Phone Book 20
Power 22
Redial / Pause 20
Scan Mode 20
Select 21
Start Black 22
Start Color 22
Up arrow 21
buttons, Productivity Suite
Attach to E-mail 27
Copy 27
Fax 27

C
Caller ID, using 53
calling card
using when faxing 50
using when setting up Quick Dial buttons 55
using when setting up Speed Dial 55
using while listening to call 52
using with On Hook dial feature 52
using with the Fax Setup Utility 58
can receive but not send fax 88
can send but not receive fax 88
cannot print from digital camera using PictBridge 79
cannot print to network printer 91
cannot scan to application 86
cannot scan to computer over network 86
cannot send or receive fax 86
cards, printing 43
cartridge error 95
cartridges, print
aligning 71
cleaning 72
installing 70
preserving 73
removing 69
wiping 72
cleaning print cartridge nozzles 72
clear ADF jam error 94
clear carrier jam error message 95
clear paper jam error 94
collated paper, loading 35
collating copies 41, 44
color ink low error 94
configuring network printer 67
connecting the printer to answering machine 14
copier does not respond 82
copy button 27
menu 23
section 28
copy troubleshooting
copier does not respond 82
partial document or photo copies 84
poor copy quality 83
scanner unit does not close 83
copying 44
cloning an image 45
customizing settings 23
enlarging an image 45
reducing an image 45
repeating an image 45
custom size paper, loading 37
customizing settings
copy 23
gulp 24
Fax Setup Utility 58
scan 24

d
defaults
Copy menu 23
Fax menu 24
Scan menu 24
digital camera (PictBridge-enabled) 64
direct IP printing 67
distinctive ring patterns 57
documents
copying 44
faxing using the computer 51
faxing using the control panel 51
loading into ADF 38
loading on scanner glass 39
printing 41
scanning images for editing 48
scanning text for editing 48
scanning to e-mail 47
DSL, using when faxing 86

e
editing
document text (OCR) 48
scanned images 48
emission notices 102, 103
enlarging an image 45

108
envelopes
  loading 36
  printing 42
error 1104 96
error messages
  alignment problem 97
  black ink low 94
  cartridge error 95
  clear ADF jam 94
  clear carrier jam 95
  clear paper jam 94
  color ink low 94
  error 1104 96
  failed to connect 97
  fax error 97
  fax mode unsupported 97
  left cartridge error 94
  left cartridge missing 96
  memory full 100
  phone line busy 99
  photo ink low 94
  remote fax error 98
  right cartridge error 94
  right cartridge missing 96
EXT port 19
e-mailing documents or photos 47

F
failed to connect error message 97
Fax
  button 27
  menu 24
  fax
    activity reports 54
    customizing settings 58
    forwarding 54
    receiving automatically 53
    receiving manually 53
    fax error message 97
    fax footer, setting up 61
    fax header, setting up 60
    fax mode unsupported error message 97
Fax Setup Utility
  Connection/Dialing tab 60
  customizing settings 58
  Receive tab 60
  Send tab 59
  Speed Dial tab 60
  using 33, 58
fax troubleshooting
  can receive but not send fax 88
  can send but not receive fax 88
  cannot send or receive fax 86
  printer received blank fax 89
  received fax has poor print quality 90
faxing
  blocking unwanted changes to settings 61
  blocking unwanted faxes 62
  choosing a fax connection 12
  customizing settings using control panel 24
  customizing settings using the computer 58
  entering a fax number 50
  sending a broadcast fax at a scheduled time 52
  sending a broadcast fax immediately 51
  sending while behind a PBX 58
  setting number of rings before automatic answering 57
  setting up dial prefix 56
  Speed Dial, setting up 55
  Speed Dial, adding groups 55
  using a calling card number 50
  using DSL 86
  using Productivity Suite 86
  using the computer 51
  using the control panel 51
  while listening to call 52
FCC notices 102, 104
  finding
    information 9
    MAC address 67
    publications 9
    Web site 10
  forwarding a fax 54

G
glossy paper, loading 35
  graphics, editing 32
  greeting cards
    loading 37
    printing 43
  Group Dial
    setting up 55
    using 50
    using the Phone Book 56

H
How To tab 30

I
I Want To menu 31
  improving print quality 71
  incorrect language appears on display 75
  index cards
    loading 37
    printing 43
  information, finding 9
  inserting PictBridge-enabled digital camera 64
  installing
    network printer 67
    print cartridges 70
    software and sharing printer on network 66
IP address, assigning 67

J
jams and misfeeds troubleshooting
  banner paper jams 94
  paper jam in ADF 92
  paper jam in printer 92
  paper or specialty media
    misfeeds 93
  printer does not feed paper, envelopes, or specialty media 93
  junk faxes, blocking 62

L
labels, loading 36
  landscape orientation, selecting 32
  language, changing on display 75
last page first 41
layout, selecting 32
left cartridge error 94
left cartridge missing error 96
  letterhead paper, loading 35
LINE port 19
loading
  banner paper 38
  coated paper 35
  custom size paper 37
  documents into the ADF 38
  documents on the scanner glass 39
  envelopes 36
  glossy paper 35
  greeting cards 37
  index cards 37
  labels 36
  letterhead paper 35
  paper 34, 35
  photo cards 37
  photo paper 35
  photos on the scanner glass 39
  postcards 37
  premium paper 35
  transparencies 36

M
MAC address, finding 67
magazine articles, loading on the scanner glass 39
Maintain/Troubleshoot
  button 27
  link 29
maintenance menus
  Copy menu 23
  Fax menu 24
  Scan menu 24
  Maintenance tab 30
Manage Documents button 26
Manage Photos button 26
memory full error message 100
multiple pages, scanning using the control panel 47
N
network name does not appear in list 92
network printer
configuring 67
installing 67
network scanning 49
network troubleshooting
cannot print to network printer 91
network name does not appear in list 92
printer to be configured does not appear in list of printers found on network 91
network troubleshooting tips 68
networking
using a print server 67
using the peer-to-peer method 66
using the point-and-print method 66
newspapers, loading on the scanner glass 39
noise emission levels 103
notices 103, 104, 107
N-up feature 42
O
OCR, editing document text 48
On Hook Dial feature 52
Online Tutorial button 27
ordering supplies 74
orientation, changing
landscape 32
portrait 32
P
page does not print 77
paper exit tray 18
paper jam in ADF 92
card jam in printer 92
paper or specialty media misfeeds 93
Paper Setup tab
changing orientation 32
changing paper size 32
paper sizes, specifying 32
paper tray 18
paper, loading 34, 35
partial document or photo copies 84
partial document or photo prints 82
partial document or photo scans 86
parts
ADF exit tray 18
ADF input tray 18
Automatic Document Feeder (ADF) 18
control panel 18
EXT port 19
LINE port 19
paper exit tray 18
paper tray 18
PictBridge port 18
power supply port 19
rear access door 19
scanner unit 18
top cover 18
USB port 19
peer-to-peer method 66
Phone Book, using 56
phone line busy error message 99
photo cards, loading 37
Photo Editor, using 32
photo ink low error 94
photo paper, loading 35
photos
adding text captions 65
album page 64
editing 32
loading on the scanner glass 39
printing 63
printing borderless 63
printing from PictBridge-enabled camera 64
printing from Productivity Suite 63
scrapbook page 64
PictBridge port 18
PictBridge-enabled camera, printing photos from 64
point-and-print method 66
poor copy quality 83
poor quality at the edges of the page 81
poor scanned image quality 85
poor text and graphic quality 80
portrait orientation, selecting 32
postcards
loading 37
printing 43
power button is not lit 76
power supply port 19
premium paper, loading 35
Preview section 28
previewing photos 29
print cartridge nozzles, cleaning 72
print cartridges
aligning 71
cleaning 72
installing 70
preserving 73
removing 69
wiping 72
Print Layout tab
changing document type 32
duplexing 32
Print Properties
I Want To menu 31
opening 31
Options menu 31
Paper Setup tab 32
Print Layout tab 32
Print Properties tabs 32
Quality/Copies tab 32
Save Settings menu 31
print quality, improving 71
print speed is slow 81
print troubleshooting
improving print quality 79
partial document or photo prints 82
poor quality at the edges of the page 81
poor text and graphic quality 80
print speed is slow 81
printer does not print or respond 81
printer does not feed paper, envelopes, or specialty media 93
printer does not print or respond 81
printer received blank fax 89
printer software
reinstalling 100
removing 100
using 26
printer status 31
printer to be configured does not appear in list of printers found on network 91
printing
blocked fax list 62
borderless photos 63
cards 43
collated copies 41
document 41
envelopes 42
greeting cards 43
index cards 43
last page first 41
multiple pages on one sheet 42
photos 63
photos from PictBridge-enabled camera 64
postcards 43
reverse page order 41
transparencies 42
Productivity Suite buttons
Attach to E-mail 27
Copy 27
Fax 27
Maintain/Troubleshoot 27
Manage Documents 26
Manage Photos 26
Online Tutorial 27
Scan 27
Scan & Edit Text (OCR) 27
Scan to PDF 27
Tips 27
using 26
Visit Us Online 26
web site 26
Productivity Suite, using 26
Productivity Tools section 28
publications, finding 9

Q
Quality/Copies tab 32
Quick Dial buttons, setting up using the computer 55
using the control panel 55

to computer 49
to e-mail 47
using the control panel 47
Scanning & Copying tab
Copy section 28
Preview section 28
Productivity Tools section 28
Scan section 28
using 28
scanning takes too long or freezes the computer 84
scrapbook page, creating 64
setup troubleshooting
cannot print from digital camera using PictBridge 79
incorrect language appears on display 75
page does not print 77
power button is not lit 76
software does not install 76
shared printing
peer-to-peer method 66
point-and-print method 66
software
All-In-One Center 27
Fax Setup Utility 33
Photo Editor 32
Print Properties 31
Productivity Suite 26
removing and reinstalling 100
Solution Center 30
software does not install 76
Solution Center
Advanced tab 31
Contact Information tab 30
How To tab 30
Maintenance tab 30
opening 30
Printer Status tab 30
Troubleshooting tab 30
using 30
Speed Dial
adding fax groups 55
setting up 55
using 50
using the Phone Book 56
supplies, ordering 74

telecommunication notices 104
text captions, adding 65
Tips button 27
top cover 18
transparencies
loading 36
printing 42
Troubleshooting tab 30
troubleshooting, copy
copier does not respond 82
partial document or photo copies 84
poor copy quality 83
scanner unit does not close 83
troubleshooting, error messages
alignment problem 97
black ink low 94
cartridge error 95
clear ADF jam 94
clear carrier jam 95
clear paper jam 94
color ink low 94
error 1104 96
failed to connect 97
fax error 97
fax mode unsupported 97
left cartridge error 94
left cartridge missing 96
memory full 100
phone line busy 99
photo ink low 94
remote fax error 98
right cartridge error 94
right cartridge missing 96
troubleshooting, fax
can receive but not send fax 88
can send but not receive fax 88
cannot send or receive fax 86
printer received blank fax 89
received fax has poor print quality 90
troubleshooting, jams and misfeeds
banner paper jams 94
paper jam in ADF 92
paper jam in printer 92
paper or specialty media misfeeds 93
printer does not feed paper, envelopes, or specialty media 93
troubleshooting, network
cannot print to network printer 91
network name does not appear in list 92
printer to be configured does not appear in list of printers found on network 91
troubleshooting, print
improving print quality 79
partial document or photo prints 82
poor quality at the edges of the page 81
poor text and graphic quality 80
print speed is slow 81
printer does not print or respond 81
troubleshooting, scan
cannot scan to application 86
cannot scan to computer over network 86
partial document or photo scans 86
poor scanned image quality 85
scan was not successful 85
scanner does not respond 84
scanning takes too long or freezes the computer 84

S

safety information 2
Saved Images tab
Open With section 29
Photo Prints section 29
Preview section 29
Productivity Tools section 29
Scan button 27
menu 24
section 28
Scan & Edit Text (OCR) button 27
Scan to PDF button 27
Scan troubleshooting
cannot scan to application 86
cannot scan to computer over network 86
partial document or photo scans 86
poor scanned image quality 85
scan was not successful 85
scanner does not respond 84
scanning takes too long or freezes the computer 84
scan was not successful 85
scanner does not respond 84
scanner glass cleaning 73
loading documents 39
scanner unit 18
scanner unit does not close 83
scanning
customizing settings 24
editing images 48
editing text 48
from magazines and newspapers 48
multiple pages 47
over a network 49

T

telecommunication notices 104
text captions, adding 65
Tips button 27
top cover 18
transparencies
loading 36
printing 42
Troubleshooting tab 30
troubleshooting, copy
copier does not respond 82
partial document or photo copies 84
poor copy quality 83
troubleshooting, setup
- cannot print from digital camera using PictBridge 79
- incorrect language appears on display 75
- page does not print 77
- power button is not lit 76
- software does not install 76

U
- unwanted faxes, blocking 62
- USB port 19

W
- Web site
- button 26
- finding 10